User Manual

’ This user manual includes detailed usage instructions for your camera.
Please read this manual thoroughly.
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Health and safety information

Always comply with the following precautions and usage tips to avoid
dangerous situations and ensure peak performance of your camera.

A Safety warnings

WARNING

Do not use your camera near flammable or explosive
gases and liquids

Do not use your camera near fuels, combustibles, or flammable
chemicals. Do not store or carry flammable liquids, gases, or explosive
materials in the same compartment as the camera or its accessories.

Keep your camera away from small children and pets

Keep your camera and all accessories out of the reach of small
children and animals. Small parts may cause choking or serious injury
if swallowed. Moving parts and accessories may present physical
dangers as well.

Prevent damage to subjects’ eyesight

Do not use the flash in close proximity (closer than 1 m/3 ft) to people
or animals. Using the flash too close to your subject’s eyes can cause
temporary or permanent damage.

Handle and dispose of batteries and chargers with care

 Use only Samsung-approved batteries and chargers. Incompatible
batteries and chargers can cause serious injuries or damage to your
camera.

* Never dispose of batteries in a fire. Follow all local regulations when
disposing of used batteries.

» Never place batteries or cameras on or in heating devices, such as
microwave ovens, stoves, or radiators. Batteries may explode when
overheated.

» Do not use a damaged power supply cord, plug, or loose outlet when
charging batteries. This may cause fire or electric shock.

A Safety precautions

CAUTION

Handle and store your camera carefully and sensibly

* Do not allow your camera to get wet—liquids can cause serious
damage. Do not handle your camera with wet hands. Water damage
to your camera can void your manufacturer’s warranty.

» Do not expose the camera to direct sunlight or high temperatures
for an extended period of time. Prolonged exposure to sunlight
or extreme temperatures can cause permanent damage to your
camera’s internal components.
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+ Avoid using or storing your camera in dusty, dirty, humid, or poorly-
ventilated areas to prevent damage to moving parts and internal
components.

» Remove the batteries from your camera when storing it for an
extended period of time. Installed batteries may leak or corrode over
time and cause serious damage to your camera.

 Prolonged usage of the camera may overheat the battery and raise
the internal temperature of the camera. If the camera stops operating,
remove the battery and allow it to cool down.

« Protect your camera from sand and dirt when using it on beaches or
in other similar areas.

« Protect your camera from impact, rough handling, and excessive
vibration to avoid serious damage.

 Exercise caution when connecting cables or adapters and installing
batteries and memory cards. Forcing the connectors, improperly
connecting cables, or improperly installing batteries and memory
cards can damage ports, connectors, and accessories.

» Do not insert foreign objects into any of your camera’s compartments,
slots, or access points. Damage due to improper use may not be
covered by your warranty.

+ Do not swing your camera by the strap. This may cause injury to
yourself or others.

+ Do not paint your camera, as paint can clog moving parts and prevent
proper operation.

« Paint or metal on the outside of the camera may cause allergic
reactions, itchy skin, eczema, or swelling for people with sensitive
skin. If you experience any of these symptoms, stop using the camera
immediately and consult a doctor.

Protect batteries, chargers, and memory cards from
damage

» Avoid exposing batteries or memory cards to very cold or very hot
temperatures (below 0 °C/32 °F or above 40 °C/104 °F). Extreme
temperatures can reduce the charging capacity of your batteries and
can cause memory cards to malfunction.

« Prevent batteries from making contact with metal objects, as this can
create a connection between the + and — terminals of your battery
and lead to temporary or permanent battery damage. Also, this may
cause fire or electric shock.

* Prevent memory cards from making contact with liquids, dirt, or
foreign substances. If dirty, wipe the memory card clean with a soft
cloth before inserting in your camera.

+ Do not allow liquids, dirt, or foreign substances to come in contact
with the memory card slot. Doing so may cause the camera to
malfunction.

« Insert the memory card in the correct direction. Inserting a memory
card in the wrong direction may damage your camera and memory
card.

« Turn off the camera when inserting or removing the memory card.

» Do not bend, drop, or subject memory cards to heavy impact or
pressure.

+ Do not use memory cards that have been formatted by other cameras
or by a computer. Format the memory card with your camera.

» Never use a damaged charger, battery, or memory card.
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Use only Samsung-approved accessories

Using incompatible accessories may damage your camera, cause injury,
or void your warranty.

Protect your camera’s lens

» Do not expose the lens to direct sunlight, as this may discolor the
image sensor or cause it to malfunction.

« Protect your lens from fingerprints and scratches. Clean your lens with
a soft, clean, debris-free lens cloth.

Important usage information

Allow only qualified personnel to service your camera

Do not allow unqualified personnel to service the camera or attempt to
service the camera yourself. Any damage that results from unqualified
service is not covered by your warranty.

Ensure maximum battery and charger life

« Overcharging batteries may shorten battery life. After charging is
finished, disconnect the cable from your camera.

« Over time, unused batteries will discharge and must be recharged
before use.

« Disconnect chargers from power sources when not in use.
 Use batteries only for their intended purpose.

Exercise caution when using the camera in humid
environments

When transferring the camera from a cold environment to a warm and
humid one, condensation may form on the delicate electronic circuitry
and memory card. In this situation, wait for at least 1 hour until all
moisture has evaporated before using the camera.

Check that the camera is operating properly before use

The manufacturer takes no responsibility for any loss of files or damage
that may result from camera malfunction or improper use.
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Concepts in Photography

Shooting postures

A correct posture for stabilizing the camera is necessary for taking a
good photo. Even if you hold a camera correctly, the wrong posture
can cause the camera to shake. Stand up straight and remain still to
maintain a steady base for your camera. When shooting with a low
shutter speed, hold your breath to minimize body movement.

Holding the camera

Hold the camera with your right hand and place you right index finger
on the shutter button. Place your left hand under the lens for support.

Standing photography

Compose your shot; stand up straight with your feet shoulder-length

apart, and keep your elbows pointed down.
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Crouching photography

Compose your shot, crouch with one knee touching the ground, and
keep a straight posture.

Aperture

The aperture, a hole that controls the amount of light that enters the
camera, is one of the three factors that determine the exposure. The
aperture housing contains thin, metal plates that open and close to let
light through the aperture and into the camera. The size of the aperture
is closely related to the brightness of a photo: the larger the aperture,
the brighter the photo; the smaller the aperture, the darker the photo.

Aperture sizes

Minimum aperture

Darker photo Brighter photo
(aperture opened slightly) (aperture opened wide)
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The size of the aperture is represented by a value known as an
“F-number.” The f-number represents the focal length divided by the
diameter of the lens. For example, if a lens with a 50 mm focal length
has an f-number of F2, the diameter of the aperture is 25 mm. (50
mm/25 mm=F2) The smaller the f-number, the greater the size of the
aperture.

The opening in the aperture is described as the Exposure Value (EV).
Increasing the Exposure Value (+1 EV) means the amount of light
doubles. Decreasing the Exposure Value (-1 EV) means the amount of
light halves. You can also use the exposure compensation feature to
fine-tune the amount of light by subdividing exposure values into 1/2,
1/3 EV, and so on.

+1EV -1EV

!

F2 F2.8 F4

Exposure Value Steps

Aperture value and the depth of field

You can blur or sharpen the background of a photo by controlling the
aperture. It is closely related to the depth of field (DOF), which can be
expressed as small or large.

A photo with a large DOF A photo with a small DOF

The aperture housing contains several blades. These blades move together

m and control the amount of light passing through the center of the aperture.
The number of blades also affects the shape of light when shooting night
scenes. If an aperture has an even number of blades, light divides into an
equal number of sections. If the number of blades is odd, the number of
sections is double the number of blades.

For example, an aperture with 8 blades divides light into 8 sections and an
aperture with 7 blades into 14 sections.

7 blades 8 blades
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Shutter speed

Shutter speed refers to the amount of time it takes to open and close
the shutter, and it is an important factor in the brightness of a photo, as
it controls the amount of light which passes through the aperture before
it reaches the image sensor.

Usually, the shutter speed is manually adjustable. The measurement

of the shutter speed is known as the “Exposure Value” (EV), which is
marked in intervals of 1 s, 1/2's, 1/4 s, 1/8 s, 1/15's, 1/1000 s, 1/2000
s, and so on.

+1 EV

Exposure

1s 1/2s 1/4's 1/8s 1/15s 1/30's

Shutter Speed

The numbers indicated on the camera are the denomi :
exposure values, which means that the higher the number, the less light
will be let in. Likewise, the smaller the EV number, the more light will be
let in.

As the photos below illustrate, a slow shutter speed allows more time
to let light in, so the photo becomes brighter. On the other hand, a fast
shutter speed allows less time to let light in and the photo becomes
darker and more easily freezes subjects in motion.

0.8s 0.004 s
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ISO sensitivity

The exposure of an image is determined by the sensitivity of the
camera. This sensitivity is based on international film standards, known
as ISO standards. On digital cameras, this sensitivity rating is used

to represent the sensitivity of the digital mechanism that captures the
image.

ISO sensitivity doubles as the number doubles. For example, an ISO
200 setting is capable of capturing images at twice the speed of an ISO
100 setting. However, higher ISO settings can result in “noise” —small
specks, spots, and other phenomena in a photo that give the shot

a noisy or dirty appearance. As a general rule, it is best to use a low
ISO setting to prevent noise in your photos, unless you are shooting in
darkened environments or at night.

Changes in the quality and brightness according to ISO sensitivity

Because a low ISO sensitivity means the camera will be less sensitive
to light, you need more light to have an optimal exposure. When using
a low ISO sensitivity, open the aperture more or reduce the shutter
speed to allow more light to enter the camera. For example, on a sunny
day when light is abundant, a low ISO sensitivity does not require a low
shutter speed. However, in a dark place or at night, a low ISO sensitivity
and a fast shutter speed will result in a blurry photo.

A photo taken with a tripod and high A blurred photo with a low ISO sensitivity
sensitivity
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How the aperture setting, shutter speed,
and ISO sensitivity control exposure

The aperture setting, shutter speed, and ISO sensitivity are closely
interconnected in photography. The aperture setting controls the
opening that regulates the light that enters the camera, while the shutter
speed determines the length of time that light is allowed to enter.

ISO sensitivity determines the speed at which the film reacts to light.
Together, these three aspects are described as the triangle of exposure.

A change in shutter speed, aperture value, or ISO sensitivity can be
offset by adjustments to the others to maintain the amount of light.
The results, however, change according to the settings. For example,
shutter speed is useful in expressing movement, aperture can control
the depth of field, and ISO sensitivity can control the graininess of a
photo.

T

Fast speed
= less light

Slow speed
= more light

Shutter speed

Fast = still
Slow = blurry

Aperture

Settings

Wide aperture

= more light
Narrow aperture
= less light

Results

Wide = small depth of field
Narrow = large depth of field

ISO sensitivity

High sensitivity

= more sensitive to light
Low sensitivity

= less sensitive to light

High = more grainy
Low = less grainy




Concepts in Photography

Correlation between focal length, angle,
and perspective

Focal length, which is measured in millimeters, is the distance between
the middle of the lens to its focal point. It affects the angle and
perspective of captured images. A short focal length translates into a

wide angle, which allows you to capture a wide shot. A long focal length

translates into a narrow angle, which allows you to capture telephoto
shots.

Short focal length

wide-angle lens

wide shot

wide angle

Long focal length

telephoto lens

telephoto shot

narrow angle

Look at these photos below and compare the changes.

200 mm angle

20 mm angle 50 mm angle

Normally, a lens with a wide angle is suitable for shooting landscapes and
/ a lens with a narrow angle is recommended for shooting sports events or
portraits.
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Depth of field

Portraits or still-life photos mostly acclaimed by people are the ones on
which the background is out of focus so the subject looks pronounced.
Depending on the focused areas, a photo can be blurred or sharpened.
This is called ‘a low DOF’ or ‘a high DOF’.

The depth of field is the focused area around the subject. Therefore,
a small DOF signifies that the focused area is narrow and a large DOF
means the focused area is wide.

A photo with a small DOF, which stresses the subject and makes the
rest of it blurred, can be obtained by using a telescope lens or selecting
a low aperture value. Conversely, a photo with a large DOF which
shows all the elements on the photo sharply focused can be achieved
by using a wide angle lens or selecting a high aperture value.

Small Depth of Field Large Depth of Field

What controls out-of-focus effects?

DOF depends on aperture value

The wider the aperture is (namely the lower the aperture value), the
lower the DOF becomes. Under the condition where the other values
including shutter speed and ISO sensitivity are equal, a low aperture
value leads to a photo with a low DOF.

50 mm F5.7 50 mm F22
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DOF depends on focal length DOF depends on the distance between the sub

the camera
The longer the focal length is, the lower the DOF gets. A telescope lens

with a longer focal length than a telescope lens with a short focal length The shorter the distance between the subject and the camera is, the
is better to take a photo of a low DOF. lower the DOF gets. Therefore, taking a photo close to a subject can
result in a photo of low DOF.

A photo taken with a 100 mm telescope lens

A photo taken with a 18 mm telescope A photo taken with a 100 mm telescope
lens lens

A photo taken close to the subject
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DOF preview

You can use the Depth preview button to get an idea of what your shot
will look like before shooting. When you press the button, the camera
adjusts the aperture to the predefined settings and shows the results on
the screen.

Depth preview
button

Composition

It is fun to take a photo of the beauty of world with a camera. No matter
how the world is beautiful, however, a poor composition cannot capture
the beauty of it.

gm—

When it comes to composition, it is very important to prioritize subjects.

Composition in photography means arranging objects in a photo.
Usually, abiding by the rule of thirds leads to a good composition.

Rule of Thirds

To use the rule of thirds, divide the image into a 3x3 pattern of equal
rectangles.

To compose photos that best emphasize the subject, make sure the
subject is located at one of the corners of the center rectangle.
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Using the rule of thirds will create photos with stable and compelling Photos with two subjects

compositions. Below are a few examples. — .
If your subject is in one corner of the photo, it creates an unbalanced

— = composition. You can stabilize the photo by capturing a second subject
in the opposite corner to balance the weight of the photo.

Unstable Stable

When taking landscape photos, centering the horizon will create an
unbalanced effect. Give more weight to the photo by moving the
horizon up or down.

Subject 1

Unstable Stable
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Flash

Light is one of the most important components in photography. It’s
not easy, however, to have an enough amount of light anytime and
anywhere. Making use of a flash allows you to optimize light settings
and create a variety of effects.

Flash, also known as strobe or speed light, helps to create adequate
exposure in low-light conditions. It is also useful in light-abundant
situations. For example, flash can be used in compensating the
exposure of a subject’s shadow or capturing clearly both the subject
and the background in backlit conditions.

Before correction After correction

Flash guide number

The model number of a flash refers to the flash’s power, and the
maximum amount of light created is represented by a value known

as a “guide number.” The bigger the guide number, the more light is
emitted from the flash. The guide number is achieved by multiplying the
distance from the flash to the subject and the aperture value when the
ISO sensitivity is set to 100.

Guide number = Flash to Subject Distance X Aperture value
Aperture value = Guide number / Flash to Subject Distance
Flash to Subject Distance = Guide number / Aperture value

Therefore, if you know the guide number of a flash, you can estimate an
optimum flash to subject distance when setting the flash manually. For
example, if a flash has a guide number of GN 20 and is 4 meters away
from the subject, the optimal aperture value is F 5.0.
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Bounce Photography

Bounce photography refers to the method of photography which
redirects the light from the subject to the ceiling or walls so that the light
spreads evenly. Normally, photos taken with flash may appear unnatural
and cast shadows. Subjects in photos taken with bounce photography
cast no shadows and look smooth due to evenly spread light.




My Camera

Learn about your camera’s layout, display icons, basic functions, supplied lens,
and optional accessories.



My Camera

Unpack

Check your product box for the following items.

Camera USB cable Rechargeable battery
(including the body cap, accessory
shoe cover, and smart shoe cover)

Software CD-ROM User manual Basic Operation Strap
(User manual included)

a The illustrations may differ from your actual items. For information about accessories, refer to page 131.



My Camera

Speaker 6 | Microphone
2 Shutter button 7 | Accessory shoe
Jog dial 8 Eyelet for camera strap
* In Shooting mode: change the
setting values of menus, adjust 9 | Image sensor
3 shutter speed in some shooting 10 | Lens removal button
modes, and change the size of a
focus area. 11 | Lens mount
* In Playback mode: enlarge or .
reduce a photo. 12 | Lens mount index

4 | AF-assist light/Timer lamp

Mode dial

o @harr: Smart Auto mode (p. 39)
+ P: Program mode (p. 40)

 A: Aperture Priority mode (p. 41)
5 | < S: Shutter Priority mode (p. 41)

+ M: Manual mode (p. 42)

* @: Lens Priority mode (p. 42)

* SCENE: Scene mode (p. 45)
&% : Movie mode (p. 47)
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1 Power switch

AEL button (p. 92)

* In Shooting mode: Lock the

2 adjusted exposure value or focus.

* In Playback mode: Protect the
displayed file.

Status lamp

* Blinking: When saving a photo,
shooting a video, sending data to a

3 computer or printer.

» Steady: When there is no data
transfer or when data transfer to a
computer or printer is complete.

Fn button
4 Access major functions and fine-tune
some settings.

Navigation button
* In Shooting mode
- AF-MF : Select an AF Mode
- IS0 : Select an ISO value
- Ej, : Select a Drive mode
- WB : Select a White Balance
* In other situations
Move up, down, left, right,
5 respectively. (You can also rotate the
navigation wheel.)
When rotating:
* Scroll to an option or menu.
* Adjust aperture value in Shooting
mode.

* Adjust the frame location when
selecting a focus manually.

Green/Delete button

* In Shooting mode: Reset the value
of Picture Wizard, White Balance,
Color Temperature, Display Color,
Timer, Flash EV, Selection AF (a
repositioned focus area is moved
back to the center), or exposure
compensation, or exposure value for
each mode.

* In Playback mode: Delete a file or
files.

&8 button

* In Shooting mode
Change the size and position of the
AF area.

* In other situations
Confirm the highlighted option or
menu.

Playback button
Enter Playback mode.

MENU button
Access options or menus.

 Scroll through files in Playback mode.

10

EV button

Press and hold [Ed], and then rotate
the jog dial to adjust the exposure
value. (p. 75)
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tripod to minimize camera movement.

Smart shoe USB and A/V port
1 Connect an optional electronic 8 Connect the camera to other devices
viewfinder. via a USB A/V cable.
2 Battery chamber cover 9 Depth preview button (p. 19)
Insert d and battery.
nsert a memory card and battery DISP button
3 | Tripod mount + In Shooting mode: View camera
settings and change options.
4 | Display 10 o g. P
* In Playback mode: View photo
5 | HDMI port information.
6 | Power adapter port
Shutter release port
7 Use a shutter release cable with a
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In Shooting mode

Capture photos 2. Shooting options (right)
- 1

Drive mode i
14m 10:00AM  2010/07/01 @ D] Histogram (p. 91)
&= London SAF, | AF mode (p. 58) (o Shooting mode
I B ER White balance (p. 53) ® Focus
+ A AW
@ ;] [; o White balance micro adjustment 4 Flash indicator™
. s | [0 |
m L 2 ISO sensitivity (p. 52) 40 Shutter speed
iy 5 | Metering (p. 71) F3.5 Aperture value
.:_/0;. Picture wizard (p. 56) Exposure value
B | Face tone AEL Auto exposure lock (p. 92)
1. Shooting options (left) ‘® | Face retouch AFL Auto focus lock (p. 92)
Description [ ] No external memory card
14M | Photo size 3. Shooting information 00 (3 | Number of available shots
Focus area option & | GPS activated* (g 09 O3 Partially charged
- - X {1(Red) : Empty (recharge the
&) | Face detection 10:00AM | Time battery)
Flash option* 2010/07/01 | Date * These icons appear when you attach an optional GPS
' ity* London | Location information* module.
=2 Flash intensity = : ** This icon appears when you attach an optional flash.
Color space i Focus aid bar (p. 64)
(M | Smart range (p. 73) L4 Auto foous frame / The icons displayed will change according to
Wy | Optical Image Stabilization (OIS) (p. 74) [ ] Spot metering area the mode you select or the options you set.
* These icons appear when you attach an optional flash. w)) Camera shake
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1. Shooting options (left) 3. Shooting information

Video size 10:00AM | Time

@, | Video quality 2010/07/01 | Date

M | Fader (p. 77) (4] Histogram (p. 91)

& | Recording voice on (p. 78) = Shooting mode

.. | Cut wind sound (p. 78) ] Focus

Wy | Optical Image Stabilization (OIS) (p. 74) F3.5 Aperture value
Exposure value

2. Shooting options (right) AEL Auto exposure lock (p. 92)

AFL Auto focus lock (p. 92)
@ Drive mode . ] No external memory card
SAF, | AF mode (p. 58) 0010 | Available recording time
EB | White balance (p. 53) @9 : Fully charged
e @ B
</ | Picture wizard (p. 56) battery)

/ The icons displayed will change according to
the mode you select or the options you set.
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In Playback mode

View photos

© mi & on 100-0001

Play videos

» PLAY o,

100-0002

O 1/40.[F3:5 o200 0003 /0 (000 @@ j0Ke Pause 10 Stop
oon ——— Descrpion | mu
-$- Location information Captured photo .l Volume
il Volume 2 RGB histogram (p. 91) 100-0002 | Folder number - File number
RAW file Shooting mode, Metering, Flash, oo Current playback time
= Print information added to file (p. 103) 3 \I-{%V:\i/t\?fﬁ)sl?:noccedsprigaure gizard, (300 Total playback time
(2o Sound Picture file (p. 45) Photo siée, Date ge, Exposure value,
Om Protected file Shutter speed, Aperture value, ISO
100-0001 Folder number - File number 4 value, Current file/the total number of
London Location information files
1/40 Shutter speed
F3.5 Aperture value
200 ISO value
D000 (/0000 Current file/the total number of files
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You can purchase optional lenses made exclusively for your NX series
camera. Learn about the functions of each lens and select one that suits
your needs and preferences.

No. ‘ Description

LLens mount index

Zoom lock switch

Zoom ring

Lens

Lens layout

Focus ring (p. 64)
SAMSUNG 20-50 mm F3.5-5.6 ED lens (example)

iFn button (p. 43)

N oo a0 DN~

Lens contacts
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Lock or unlock the lens To unlock the lens, rotate the zoom ring counter-clockwise until you hear
the click.
To lock the lens, pull and hold the zoom lock switch away from the

camera body and rotate the zoom ring clockwise.

u You cannot take a shot when the lens is locked.
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SAMSUNG 18-55 mm F3.5-5.6 OIS lens (example) SAMSUNG 20 mm F2.8 lens (example)

Description

No. ‘ Description
iFn button (p. 43)

Lens mount index

Zoom ring .
LLens mount index

Focus ring (p. 64) Focus ring (p. 64)

Lens hood mount index
Lens

Lens
Lens contacts

B WIN| I~

OIS switch (p. 74)
AF/MF switch (p. 58)

m\lCD(J'I-BOOI\J—\ﬁ

Lens contacts
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Lens markings

Aperture value

Find out what the numbers on the lens signify. 1 A range of supported aperture values. For example, F 1:4-5.6
means the maximum aperture value range from 4 to 5.6.
SAMSUNG 50-200 mm F4-5.6 ED OIS lens (example) Focal length
The distance from the middle of the lens to its focal point (in
- . = millimeters). This figure is expressed in a range: minimum focal

- 2 | length to maximum focal length of the lens.

Longer focal lengths result in narrower angles of view and the
subject is magnified. Shorter focal lengths result in wider angles of
view.

N m\ﬁmm’\
! I I I I I I I I I I I ! ! ! L ED
|

1:4-56 50200 ED 0IS ©52

1:4-5.6 50-200 ED 0IS @52 3 ED stands for Extra-low Dispersion. Extra-low dispersion glass is
effective in minimizing chromatic aberration (a distortion that occurs

T when a lens fails to focus all colors to the same convergence point).

|
2 3 45 OIS (p. 74)
4 Optical Image Stabilization. Lenses with this feature can detect
camera shake and effectively cancel out the movement inside the
camera.

%}

5 The lens diameter. When you attach a filter to the lens, make sure
that the diameters of the lens and the filter are the same.
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You can purchase additional accessories including flash, GPS module, No. ‘ Desoription

and an electronic viewfinder that can help you take better and more
convenient shots. READY lamp/Test button
[MODE] button

For more information, refer to the manual for each accessory.
Power button

Accessory shoe fastening dial

a The illustrations below may differ from the actual items.
Accessory shoe connection

Battery cover

Bulb

1
2
3
4
5
6
7

Flash layout

Connect the flash

| Remove the accessory shoe cover from the camera.
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C Connect the flash by sliding it into the accessory shoe. Y Press the power button on the flash.

GPS module layout

3 Lock the flash into place by turning the accessory shoe
fastening dial clockwise towards LOCK.

No. ‘ Description

Status lamp

Power button

Accessory shoe fastening dial

Accessory shoe connection

b wWN| -

Battery cover
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Attach the GPS module 3 Lock the GPS module into place by turning the accessory
shoe fastening dial clockwise towards LOCK.

| Remove the accessory shoe cover from the camera.

Z Mount the GPS module by sliding in into the accessory
shoe. Y Press the power button of the GPS module.
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Attach the electronic viewfinder 3 Press [Power] (1) on the viewfinder and rotate the [Diopter
adjustment dial] (2) to adjust the diopter to fit your eye-
| Remove the accessory shoe cover and the smart shoe sight.

cover on the camera.

Z Mount the electronic viewfinder on the accessory shoe (1)
and smart shoe (2) of the camera.

- Take caution not to damage the connector (3).
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Two simple shooting modes—Smart Auto and Scene mode—help you
take photos with numerous automatic settings. Additional modes allow
for greater customization of settings.

Icon Description

@iarr | Smart Auto mode (p. 39)
Program mode (p. 40)

Aperture Priority mode (p. 41)
Shutter Priority mode (p. 41)

Manual mode (p. 42)

@ 2T w>x o

Lens Priority mode (p. 42)
SCENE | Scene mode (p. 45)
Movie mode (p. 47)

C.xr Smart Auto mode

In Smart Auto mode, the camera recognizes surrounding conditions
and automatically adjusts factors that contribute to exposure, including
shutter speed, aperture value, metering, white balance, and exposure
compensation. As the camera controls most of the functions, some
shooting functions are limited. This mode is useful for capturing quick
snapshots with the least amount of adjustment.
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P Program mode

The camera automatically adjusts shutter speed and aperture value so ProgramIShift function lets you adjust the shutter speed and aperture

that an optimal exposure value can be achieved. value while the camera maintains the same exposure. When you rotate
the jog dial to the left, the shutter speed decreases and the aperture

This mode is useful when you want to take shots of constant exposure value increases. When you rotate the jog dial to the right, the shutter

while being able to adjust other settings. speed increases and the aperture value decreases.
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A Aperture Priority mode S Shutter Priority mode

In Aperture Priority mode, the camera automatically calculates shutter In Shutter Priority mode, the camera automatically adjusts the aperture
speed according to the aperture value you choose. You can adjust the value according to the shutter speed you choose. This mode is useful
depth of field (DOF) by changing the aperture value. This mode is useful for capturing photos of fast-moving subjects or for creating tracer

for taking portraits and landscape shots. effects in a photo.

For example, set the shutter speed to over 1/500 s to freeze the
subject. To make the subject appear blurred set the shutter speed to
below 1/30 s.

Large Depth of Field Small Depth of Field

Slow shutter speed Fast shutter speed
In low-light settings, you may need to increase the ISO sensitivity to prevent .
/ blurred photos. In order to compensate for the reduced amount of light allowed by fast
/ shutter speeds, open the aperture and let in more light. If your photos are still

too dark, increase the ISO value.
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M Manual mode

Manual mode lets you adjust the shutter speed and aperture value
manually. In this mode, you can fully control the exposure of your
photos.

This mode is useful in controlled shooting environments, such as a
studio, or when it is necessary to fine-tune camera settings. The Manual
mode is also recommended for shooting night scenes or fireworks.

Framing Mode

When you adjust the aperture value or shutter speed, the exposure
changes according to the settings, so the display may darken. With this
function on, the brightness of the display is constant regardless of the
settings, so you can better frame your shot.

To use Framing In Shooting mode, press [MENU] » (23 P Framing Mode
Mode, » Off or On.

Use a bulb

Use a bulb to shoot night scenes or the night sky. While you are
pressing the shutter button, the shutter is left open so you can create
moving light effects.

Completely scroll the jog dial to the left to Bulb. B> Press and

To use a bulb, hold [Shutter] for the desired time.

@ Lens Priority mode

You can select an appropriate scene (i-Scene) to the lens you attached.
Available scenes may differ depending on the lens you are using.

|1 Attach an iFn lens.
C Rotate the mode dial to @.

3 Press [iFn].
« You can use this function by pressing [Fn].
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Y Adjust the focus ring to select a scene. Use i-Function in PASM modes

* You can also rotate the navigation button to select a scene. When you use the iFn button on an iFn lens, you can manually select

and adjust shutter speed, aperture value, exposure value, ISO sensitivity,
and white balance on the lens.

| Press [iFn] on the lens to select a setting.
« You can also scroll the jog dial to select a setting.

5 Half-press [Shutter] or press [9.'5] to save.

6 Fully press [Shutter] to take the photo.

AUTO 100 125 160

os\ -k

20

/ Available scene modes (for 20-50 lens) : Beauty Shot, Portrait, Children,
Backlight, Landscape, Sunset, Dawn, Beach & Snow, Night
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C Adjust the focus ring to select an option.

« You can also rotate the navigation button to select an option.

3 Half-press [Shutter] or press [°K] to save.
H

Y Fully press [Shutter] to take a photo.

S

Shutter speed

Aperture value - O - O
Exposure value O O O -
White balance O @) @) @)
ISO O 0 @) O

/ To select items to appear when you press [iFn] on the lens in Shooting mode,
press [MENU] P> £8% B> Lens i-Function » an option » Off or On.
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SCENE Scene mode

In Scene mode, the camera selects the best settings for each type of
scene.

You can select a desired scene by pressing [Fn] in Shooting mode.

Option ‘ Description

2 Sound picture: Add voice memos
@ | pefore and after taking photos.

‘Q Beauty Shot: Hide facial
imperfections

Portrait: Automatically detect and
Q focus on human faces so that you
can achieve clear, soft portraits

[e

Children: Make children appear more
noticeable by capturing their clothes
and the background vividly

N\
N

Sports: Capture fast moving
subjects.

"‘:Q Backlight: Capture backlit subjects
Close Up: Capture detailed parts of
\/ a subject or small subjects, such as

flowers or insects
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(Option_ Deseripton |

o o ]

E Text: Clearly capture text from printed

*) Night: Capture scenes at night or in
or electronic documents

low lighting

Landscape: Capture still-life scenes

and landscapes ose Fireworks: Capture colorful fireworks

oule at night

0o,
oe®

& | Sunset: Capture scenes at sunset,
with natural-looking reds and yellows

g

Dawn: Capture scenes at sunrise

Beach & Snow: Reduce
V‘ underexposed photos due to sunlight
reflected from sand or snow
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8 Movie mode a

In Movie mode, you can shoot videos in High Definition (1280x720) and
capture sound via the camera’s microphone.

In order to adjust the exposure level, you can select Program in

the Movie AE Mode options menu so that the aperture value can

be automatically set or select Aperture Priority to manually set the
aperture value. While shooting a video, press [Depth Preview] once to
activate the AF function.

Select Fader in the Movie AE Mode options menu to fade in or out
a scene. You can also select Wind Cut to prevent some surrounding
noise from being recorded and select Voice to mute or un-mute voice.

The camera lets you capture video files up to 25 minutes in length and
saves the files in MP4(H.264) format.

H.264 (MPEG-4 part10/AVC) is the latest video coding format established
in 2003 collaboratively by ISO-IEC and ITU-T. Since this format uses a
high compression rate, more data can be saved in less memory space.

If you have the image stabilizer option on when shooting a movie, the
camera may record the image stabilizer sound.

The zoom sound may be recorded if you use the zoom while recording a
video.

If you remove the camera lens while recording a movie, the recording will
be interrupted. Do not change the lens while recording.

If you change the shooting angle of the camera suddenly while shooting
a movie, the camera may not be able to record images accurately. Use a
tripod to minimize camera shake.

In Movie mode, the camera supports only the Multi AF function. You
cannot use any other focus area setting functions, such as Face
Detection AF.

When the size of a movie file exceeds 4GB, the camera automatically
stops recording. If this occurs, continue shooting by starting a new movie
file.

If you use a slow writing memory card, the recording of your movie can be
interrupted because the card cannot process data at the rate the video is
being shot. If this occurs, replace the card with a faster memory card or
reduce the image size (for example, from 1280x720 to 640x480).

When formatting a memory card, always format using the camera. If

you format on another camera or a PC, you can lose files on the card or
cause a change in the capacity of the card.



My camera > SNO0tING modes

Available functions by shooting mode
For details about shooting functions, see Chapter 2. Exposurelfocus fock (p. 76) PIA/SHE
Noise Reduction (p. 90) P/A/S/M

* Some functions are limited in these modes.

Size (p. 50) %@gM/@/SCENE/

Quality (p. 51) P/A/S/M/®/SCENE*/»38

ISO (p. 52) P/A/S/M

White Balance (p. 53) P/A/S/M/\38

Picture Wizard (p. 56) P/A/S/M/\38

Color Space (p. 57) P/A/S/M/®/SCENE/ Cnrr

AF Mode (p. 58) P/A/S/M/®/SCENE/»38*

AF Area (p. 60) P/A/S/M/@/SCENE*

AF Priority (p. 63) P/A/S/M

MF Assist (p. 64) P/A/S/M/®/SCENE/)88/Carr

Drive (Continuous/Burst/Timer/BKT) P/A/S/M/@*/SCENE*/

(p. 65) 8/ Chinrr”

Flash (p. 69) P/A/S/M/@/SCENE*/ Chiarr

Smart Range (p. 73) P/A/S/M

Metering (p. 71) P/A/S/M/HR

OIS (p. 74) P/A/S/M/\38

AF Lamp (p. 90) P/A/S/M/@/SCENE/»8/ Ciiarr

Exposure compensation (p. 75) P/A/S/@/SCENE/»38




Shooting Functions

Learn about the functions you can set in Shooting mode.
You can enjoy more customized photos and videos by using the shooting functions.
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As you increase the resolution, your photo or video will include more lcon [Size | Recommendedfor |
pixels, so it can be printed on larger paper or displayed on a larger Printin .
. ! ek ) . . g on A1 paper or viewing on an
screen. When you use a high resolution, the file size will also increase. [2] | 12M4592x2584 (16:9) | |5,
Select a low resolution for photos that will be displayed in a digital Printing on A3 baner or viewing on an
picture frame or uploaded to the web. 8M 3872X2176 (16:9) HDTV.g pap 9
[Bu] | 5M 3008X1688 (16:9) Printing on A4 paper or viewing on an
HDTV.
. Printing on A5 paper or viewing on an
[Zv] | 2M 1920X1080 (16:9) HOTV
e :
; %I}{I 9M 3056X3056 (1:1) Printing a square photo on A2 paper.
4 -
\ /4 .'.«\-' \ 6.7m | 6.7M 2592X2592 (1:1) Printing a square photo on A3 paper.
Vd :
' *M | 4M 2000X2000 (1:1) Printing a square photo on A4 paper.
1.6m | 1.6M 1280X1280 (1:1) Printing a square photo on A5 paper.
In Shooting mode, press [Fn] » Photo Size or Movie Size
» an option.
Video size options
. . Icon | Size Recommended for
Photo size Optlons 1280 (16:9) Viewing on an HDTV.
Icon ‘ Size ‘ Recommended for 640 | 640 (4:3) Viewing on a TV.
14Mm | 14M 4592X3056 (3:2) Printing on A1 paper. 320 | 320 (4:3) Uploading on the web.
10m | 10M 3872X2592 (3:2) Printing on A2 paper.
6M | 6M 3008X2000 (3:2) Printing on A3 paper.
2M | 2M 1920X1280 (3:2) Printing on A5 paper.
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The camera saves photos in either the JPEG or RAW format.

Photos captured by a camera are often transformed to the JPEG format
and stored in the memory according to the settings of the camera at the
time of shooting. RAW files are not transformed to the JPEG format and
are stored in the memory without any changes.

RAW files have the file extension “SRW”. To adjust and calibrate
exposures, white balances, tones, contrasts, and colors of the RAW
files, or to convert them into JPEG or TIFF format, use the Samsung
RAW Converter program found on the supplied CD-ROM. Ensure you
have enough available memory to save photos in the RAW format.

To set the quality, In Shooting mode, press [Fn] » Quality > an option.

Photo quality options

Option | Format Description
Super Fine:
B | JPEG » Compressed for the best quality.
* Recommended for printing in large size.
Fine:
@E JPEG » Compressed for better quality.
* Recommended for printing in normal size.

Normal:
@ JPEG * Compressed for normal quality.
N * Recommended for printing in small size or
uploading to the web.
RAW:
RAW * Save a photo without data loss.
* Recommended for editing after shooting.
RAW + S.Fine: Save a photo in both the JPEG
s RAW:JPEG (S.Fine quality) and RAW format .
- RAW + Fine: Save a photo in both the JPEG
@ RAW+JPEG (Fine quality) and RAW format.
@ RAW4JPEG RAW + Normal: Save a photo in both the JPEG

(Normal quality) and RAW format.

Video quality options

Option | Extension Description
IE‘N MP4(H.264) Normal: Record videos in normal quality.
B | MP4(H.264) HQ: Record videos in high quality.
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The ISO sensitivity value represents the sensitivity of camera to light. Examples

The larger the ISO value, the more sensitive the camera is to light.
Consequently, by selecting a higher ISO sensitivity value, you can take
photos in dim or dark places at faster shutter speeds. However, this
may increase electronic noise and result in a grainy photo.

To set ISO

e In Shooting mode, press [ISO] P> an option.

ISO 100 ISO 400

Expand ISO value

You can select higher ISO values up to ISO 6400.

To expand I1SO In Shooting mode, press [MENU] B> (S5 P ISO Expansion
value, » On.

ISO 800 ISO 3200

* Increase the ISO value in places where flash use is prohibited. You can take
a a clear photo by setting a high ISO value without having to secure more
light.
* Use the Noise Reduction function in order to reduce the visual noise that
can appear on photos of a high ISO value over 3200. (p. 90)
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The color of a photo depends on the type and quality of the light source.
If you want the color of your photo to be realistic, select an appropriate
lighting condition to calibrate the white balance, such as Auto WB,
Daylight, Cloudy, or Tungsten, or adjust color temperature manually.
You can also adjust color for the preset light sources so that the colors
of the photo match the actual scene under mixed lighting conditions.

To set the white , .
In Shooting mode, press [WB] P> an option.

White balance options

opionDssorption

(e Auto WB*: Use automatic settings depending on the lighting
conditions.

Daylight*: Select when taking outdoor photos on a sunny day.
‘@ This option results in photos closest to the natural colors of the
scene.

Cloudy™: Select when taking outdoor photos on a cloudy day
o or in shadows. Photos taken on cloudy days tend to be more
pbluish than on sunny days. This option offsets that effect.

Fluorescent White*: Select when shooting under a daylight
v fluorescent lamp. Especially for white fluorescent light with a
color temperature of about 4200K.

1.
4!1_!"

Fluorescent NW*: Select when shooting under a daylight
fluorescent lamp. Especially for white fluorescent light of very
white hues with a temperature of about 5000K.

Fluorescent Daylight™: Select when shooting under a daylight
fluorescent lamp. Especially for white fluorescent light of slightly
bluish hue with a temperature of about 6500K.

Tungsten™: Select when taking indoor photos under
incandescent bulbs or halogen lamps. Incandescent tungsten
bulbs tend to have a reddish hue. This option offsets that effect.

Flash WB*: Select when using an optional flash.

Custom Set:

Use your pre-defined settings.

You can manually set the white balance by shooting a white
sheet of paper. Fill the spot metering circle with the paper and
set the white balance.

* These options can be customized.
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| Option | Description Customize preset options

E:/Iolor Temp," , You can also customize preset white balance options. In Shooting
anually adjust the. color temperature. of the light souree. mode, press [MENU] » (S5 or €9 » White Balance » an option, and

Color temperature is a measurement in degrees Kelvin

that indicates the specific type of light source. As the color then press [Fn].

temperature increases, the color distribution becomes cooler.

Alternatively, as the color temperature decreases, the color @) WB Adjust

distribution becomes warmer.

10,000 K — Clear sky
8,000 K
— Fluorescent_H
m 6,000 K — — Cloudy
5,000 K — — Daylight

{MENU: Back =@ Reset

— Fuorescent_L

4,000 K —
— Halogen lam
3,000 K — 9 P
— Tungsten
2,000 K Candle light
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Examples

Daylight

Fluorescent Daylight Tungsten
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Picture Wizard lets you apply different photo styles to your photo to Examples
create various looks and emotional moods. You can also create and
save your own photo styles by adjusting color, saturation, sharpness,
and contrast for each style.

There is no rule for which style is suitable in which conditions.
Experiment with different styles and find your own settings.

To set a photo In Shooting mode, press [Fn] » Picture Wizard »
style, an option.

Standard Vivid Portrait

Landscape Forest

Cool Classic

You can also adjust the value of the preset style settings. Select a Picture
/ Wizard option, press [AF-MF] and adjust color, saturation, sharpness, or
contrast.
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Digital imaging devices such as digital cameras, monitors, and printers
have their own methods for representing colors, which are called color
spaces.

Your camera lets you select two color spaces: sRGB or Adobe RGB.

sRGB is widely used for creating colors on PC monitors and is also the
standard color space for Exif. SRGB is recommended for regular images
and images you intend to publish on the Internet.

Adobe RGB is used for commercial printing and has a larger color range
than sRGB. Its wider range of colors helps you to easily edit photos on a
computer. Note that individual programs are generally compatible with a
limited number of color spaces. If you open an image in a program that
is not compatible with the image’s color space, the colors will appear
lighter.

To set the color In Shooting mode, press [MENU] » (3 » Color Space »
space, an option.

Adobe RGB

sRGB
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Learn how to adjust the camera’s focus according to the subjects. SI ng |e AF

You can select a focusing mode appropriate to the subject among Single AF is appropriate for shooting a still subject. When you press
Single Auto Focus, Continuous Auto Focus, and Manual Focus. The AF [Shutter] halfway, the focus fixes in the focus area. The area turns green
function is activated when you press [Shutter] halfway. In the MF mode, when the focus is achieved.

you have to rotate the focus ring on the lens to focus manually.

In most cases, you can have a focus by selecting Single AF. Fast
moving subjects or subjects of a color similar to the background
are difficult to focus. Select an appropriate focusing mode for such
instances.

If your lens has an AF/MF switch, set the switch to MF to adjust the
focus manually. When your lens has no AF/MF switch, press [AF-MF] to
select a desired AF mode.

LS i eh ) In Shooting mode, press [AF-MF] »> an option.
focus mode,
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Continuous AF Manual Focus

While you are pressing [Shutter] halfway, the camera continues to You can manually focus on a subject by rotating the focus ring on the
automatic focusing. Once the focus area is fixed on the subject, lens. The MF Assist function lets you easily achieve a focus. While

the subject is always in focus even when moving. This mode is you are rotating the focus ring, the focus area is magnified or the
recommended for shooting a person on a bicycle, a running dog, or a focus aid bar appears to help you achieve a clear focus. This mode is
car racing scene. recommended for shooting an object similar in color to the background,

a night scene, or fireworks.




Shooting Functions

The AF area function changes the positions of the focus area.

Generally, cameras focus on the nearest subject. When there are a lot
of subjects, however, unwanted subjects can be in focus. In order to
prevent unwanted subjects from being in focus, change the focus area
so that a desired subject is in focus. You can get a clearer and sharper
photo by selecting an appropriate focus area.

To set the auto : :
In Shooting mode, press [Fn] »> AF Area B> an option.

Selection AF

You can set the focus on an area you want. Apply an out-of-focus effect
to make the subject more distinguishable.

The focus on the photo below was repositioned and resized so that it
fits the subject’s face.

E AF Zoom @ Move

u To resize or move the focus area, in Shooting mode, press [%].



Shooting Functions > AF Area

Multi AF Face Detection AF
The camera displays a green rectangle in places where focus is set The camera focuses on human faces preferentially. Faces of up to 10
correctly. The photo is divided into two or more areas, and the camera people can be detected. This setting is recommended for shooting a
obtains focus points of each area. It is recommended for scenery group of people.
photos.

When you press [Shutter] halfway, the camera focuses on faces as
When you press [Shutter], the camera displays the focus areas in green shown in the photo below. In cases of shooting a group of people, the
as shown in the photo below. camera displays the focus on the nearest person’s face in white and the

rest of the people’s faces in gray.




Shooting Functions > AF Area

Self-Portrait AF

It can be difficult to check whether your face is in focus when you are
taking a self-portrait. When this function is on, the focus distance is set
to close-up and the beep from the camera gets faster when in focus.




Shooting Functions

The camera takes a shot only if the focus is set correctly when you
press [Shutter].

Turn on this function to always get a properly focused photo. Turn it off
to take a photo regardless of focus.

To set the focus In Shooting mode, press [MENU] » (23 »> AF Priority P>
priority, an option.




Shooting Functions

In the manual focus (MF) mode, you have to rotate the focus ring on
the lens to focus manually. When you set the MF Assist function, you
can achieve a clearer focus. This function is only available on a lens that
supports manual focus.

To set the manual In Shooting mode, press [MENU] » (3 or €9 » MF Assist
focus assist, P an option.

* Default

(Option —Descrpon

Off Do not use the function.
The focus area is magnified when you rotate the focus ring.
Enlarge*
The focus aid bar rises as the focus improves, when you
rotate the focus ring.
FA

A




Shooting Functions

You can set the shooting method such as Continuous, Burst, Timer
and so on.

Select Single to capture one photo at a time. Select Continuous or
Burst to shoot fast moving subjects. Select AE BKT, WB BKT or

P Wiz BKT to adjust exposure, white balance, or apply Picture Wizard
effects. You can also select Timer to take a photo of yourself.

To set the . © ;
shooting method, In Shooting mode, press [&,] P> an option.

Single

Capture one photo whenever you press [Shutter]. Recommended for
general conditions.

Continuous

Continuously capture photos while you are pressing [Shutter]. You can
take up to 3 shots per second.




shooting Functions > Drive (Shooting method)

Burst Timer
Consecutively capture up to 10 shots per second (3 seconds), 15 shots Capture a photo with a delay of 2 to 30 seconds. The delay is
per second (2 seconds), or 30 shots per second (1 second) when you adjustable in increments of 1 second.

press [Shutter] once. Recommended for shooting the rapid motion of
fast moving subjects such as racing cars.

£ &£ % & ¢

!/ | To set the number of shots, press [MENU] » (33 P Drive »

Burst, and then press [Fn].

/ To set the delay, press [MENU] » (33 » Drive » Timer, and
then press [Fn].



shooting Functions > Drive (Shooting method)

AE BKT WB BKT

When you press [Shutter], the camera takes 3 consecutive shots: When you press [Shutter], the camera takes 3 consecutive shots:

the original, one a step darker, and one a step lighter. Use a tripod to the original and two more with different white balance settings. The
prevent blurry photos as the camera takes three shots continuously. original photo is taken when you press [Shutter]. The other two are
You can adjust the settings in BKT Set menu. automatically adjusted according to the white balance you have set.

You can adjust the settings in BKT Set menu.

Exposure +2
Original WB-2

Exposure -2

WB+2
Original



shooting Functions > Drive (Shooting method)

P Wiz BKT BKT Set

When you press [Shutter], the camera takes three consecutive shots, You can set up the options for AE BKT, WB BKT, P Wiz BKT.
each with a different Picture Wizard setting. The camera takes a shot

and applies the three Picture Wizard options you have set to the image In Shooting mode, press [MENU] » (33 P BKT Set b
taken. You can select three different settings in BKT Set menu. bracketing option, JRElelsielak

Opion ————Dosorpion

Set the order and the area of bracket.

¢ BKT Order: Set the order in which the camera
takes the original, lighter, and darker shot
(represented by O, +, and -).

* BKT Area: Set the exposure range of the

Retro 3 AE BKT shots.

Standard Adjust the white balance interval range of the

3 WB BKT shots.

WB BKT Set For example, AB-/+3 adjusts the Amber value plus
or minus three steps. MG-/+3 adjusts the Magenta
value the same amount.

AE BKT Set

Vivid

Select 3 Picture Wizard settings the camera uses

P Wiz BKT Set to take the 3 P Wiz BKT shots.




Shooting Functions

In order to take a realistic photo of a subject, the amount of light should
be constant. When the light source varies, you can use an optional
flash and supply a constant amount of light. Select appropriate settings
according to a light source and a subject.

To set flash In Shooting mode, press [MENU] » (33 » Flash »
options, an option.

Flash options

Option ‘ Description

@ Off: Do not use the flash.

Smart Flash: The camera automatically adjusts the brightness
of the flash according to the amount of light in the surrounding
environment.

SMART

Auto + Red: The flash automatically fires and prevents red-eyes.

iA Auto: The flash automatically fires in dark places.
@®
i Fill in: The flash fires whenever you take a photo.

% Fill-in Red: The flash fires whenever you take a photo and
® prevents red-eyes.

¥

1st Curtain: The flash fires
immediately after the shutter
opens. The camera captures a
photo of a subject earlier in an
action sequence clearly.

<
<%

Ball moving directi .

%

2nd Curtain: The flash fires just
before the shutter closes. The
camera captures a photo of a
subject later in an action sequence
clearly.

4

* The options may differ depending on the shooting mode.

* There is an interval between two bursts of the flash. Do not move until the
flash fires a second time.

* You can use the flash and adjust the amount of light only when you use the
NX exclusive external flash.

Use only Samsung-approved flashes. Using incompatible flashes may
damage your camera.



Shooting Functions > Flash

Correct the red-eye effect Adjust the flash intensity
If the flash fires when you take a photo of a person in the dark, a red Adjust the flash intensity to avoid overexposure or underexposure. You
glow may appear in the eyes. To prevent this, select Fill-in Red. can adjust it by + 2 levels. Press [Fn] to set the intensity.

To set the flash To set the flash intensity, In Shooting mode, press [MENU] P>
intensity, (3> » Flash » an option P [Fn].

@‘9 Flash Exposure Value

Without red-eye correction With red-eye correction

\mENUy Back {~@- Reset




Shooting Functions

The metering mode refers to the way in which a camera measures the
quantity of light.

The camera measures the amount of light in a scene, and in many of its
modes, uses the measurement to adjust various settings. For example,
if a subject looks darker than its actual color, the camera takes an
overexposed photo of it. If a subject looks lighter than its actual color,
the camera takes an underexposed photo of it.

The brightness and overall mood of the photo can also be affected by
how the camera measures the amount of light. Select an appropriate
setting for a shooting condition.

l?)tsig:la metering In Shooting mode, press [Fn] > Metering »> an option.

Spot

The Spot mode calculates the amount of light in the center. When you
take a photo in conditions where there is a strong backlight behind

a subject, the camera adjusts the exposure so as to shoot a subject
correctly. For example, when you select the Multi mode in a strong
backlight condition, the camera calculates that the overall amount of
light is abundant, which results in a darker photo. The Spot mode can
prevent this situation as it calculates the amount of light in a designated
area.

The subject is in bright color while the background is dark. The Spot
mode is recommended for a situation like this where a huge difference in
the exposure exists between a subject and a background.

Link AE to AF Point

When this function is turned on, the camera automatically sets an
optimal exposure by calculating the brightness of the focus area. This
function is only available when you select either Spot metering or Multi
metering, and Selection AF.

To set this In Shooting mode, press [MENU] P> (23 P Link AE to AF
function, Point »> an option.



Shooting Functions > IMIetering

Center-weighted Multi

The Center-weighted mode calculates a broader area than the Spot The Multi mode calculates the amount of light in multiple areas. When
mode does. It sums up the amount of light in the center portion of light is sufficient or insufficient, the camera adjusts the exposure by
the shot (60 ~ 80%) and that of the rest of the shot (20 ~ 40%). It averaging the overall brightness of the scene. This mode is suitable for
is recommended for situations where there is a slight difference in general photos.

brightness between a subject and a background or an area of the
subject is large compared to the overall composition of the photo.




Shooting Functions

This function automatically corrects the loss of bright detail that can
occur due to shading differences in the photo.

Without Smart Range effect With Smart Range effect

In Shooting mode, press [Fn] »> Smart Range »
an option.

To set Smart
Range options,




Shooting Functions

Use the Optical Image Stabilization (OIS) function to minimize camera O|S options

shake. OIS may not be available with some lenses.
Option ‘ Description

Came shake tends to occur in dark places or when shooting indoors. In . o .
. . i Mode 1: The OIS function is applied only when you press the
such cases, thg camera uses slpwer shutter speeds in order to increase W81 | shutter in full or half.
the amount of light taken in, which can result in a blurry photo. You can
prevent this situation by turning on the OIS switch. W2 | Mode 2: The OIS function is always on.

This function is only available when your lens has an OIS switch and you
have turned the switch.

Without OIS correction With OIS correction

To set OIS . ;
In Shooting mode, press [Fn] P> OIS B an option.



Shooting Functions

The camera automatically sets the exposure by measuring the levels

of light from the photo’s composition and the position of a subject. If
the exposure set by the camera is higher or lower than you expected,
you can adjust the exposure value manually. The exposure value is
adjustable in +3 increments. The camera displays the exposure warning
in red for each step beyond +3 range.

To adjust the exposure value, hold down [Ed] and scroll left or right on
the jog dial.

You can check the exposure value by the position of the exposure level
indicator.

Exposure warning Standard exposure index

®
3 2 3 2 1 0 1 2
] Jeefeej e
Ae
dl
|

3

Exposure level
indicator

+

J
|
Ll

Decreased exposure Increased exposure
(darker) (brighter)

Original




Shooting Functions

When you cannot achieve an appropriate exposure because of a strong
color contrast or you want to take a photo on which the subject is out of
the auto focus area, lock the focus or exposure and then take a photo.

To lock the exposure or focus, adjust the photo’s composition on which
you want to focus or calculate the exposure, and then press [AEL].

After locking the exposure or focus, aim the lens where you desire, and
press [Shutter].

You can change the function assigned to the button to focus lock, or both of
/ them. A function executed by half-pressing [Shutter] varies according to the
function assigned to [AEL]. (p. 92)



Shooting Functions

The functions available for video are explained below. Fader

You can fade in or fade out a scene using the fader function on the
camera without having to do it on a PC. Use the function appropriately

Movie AE Mode and add dramatic effects on your videos.

Set the aperture value for shooting a movie.
To set fader ; ’
aptions, In Shooting mode, press [Fn] »> Fader »> an option.

In Shooting mode, press [Fn] > Movie AE Mode »

To set movie
aperture options, an option.
Option | Description
GBI ‘ Eeree o P | Off: Fader function not used.

P Program: The aperture value is adjusted automatically. In: Scene gradually fades in.

Aperture Priority: Set the aperture value manually before Out: Scene gradually fades out.

A recording a video. Rotate the navigation button to adjust the
aperture value.

In-out: The fader function is applied at the start and end of the
scene.

HHA




Shooting Functions > Video functions

Wind Cut Voice
When you record videos in noisy environments, unintended sounds Sometimes, a muted video is more appealing than the one with sound.
can be recorded in videos. In particular, severe wind noise recorded Turn the voice off to record a muted video.

in videos distracts you from enjoying your videos. Use the Wind Cut

function to remove some surrounding noise in addition to wind noise. :
To set voice ; . .
. In Shooting mode, press [Fn] » Voice » an option.
options,
To set Wind Cut In Shooting mode, press [MENU] » ©3 B Wind Cut
options, P an option.

Auto Focus

While recording a movie, press [Depth Preview] once to activate the AF
function and once again to cancel the function. This function may not
work depending on the lens you are using.

Depth preview
button




Playback/Editing

Learn about how to play back and edit photos and videos.
Refer to chapter 5 for editing files on a PC.



Playback/Editing

Learn how to search photos and videos quickly through the thumbnail VleW image th um bnai |S
view and to protect and delete files.

In order to search for photos and videos you want, convert to the
thumbnail view. The thumbnail view displays up to 20 images at a time
. so that you can easily look through items you wish to find. You can
View phOtOS also classify and display files by their type, day recorded, and week

recorded.
1 Press [2]].
 The most recent file you captured will be displayed.

C Rotate the navigation button or press [E.;._’,/WB] to scroll
through files.

& mw & on 100-0001
London

06.20 : 06.28 ' : 07.18 : 08.02
' Filter 2010/07/01

7 7 Scroll the jog dial left to display 9 or 20 thumbnails.
Q [:\‘j\ @  Scroll the jog dial right to return to the previous mode.




Piayback/Editing > S€Arch and manage files

View files by category in Smart Aloum Delete files

1 In the thumbnail view, press [MENU]. Delete files in Playback mode and secure more space on your memory
card. Protected files are not deleted.

C Select a category and press [%].

Option ‘ Description Delete a single file

Type Viewfiles by the file type such as photo, video, or You can select a single file and delete it.
photo with a voice memo.
Date View files by the date they were saved. '| In playback mode, select a file and press Mﬁ]
Week View files by the week they were saved.
View file by the place they were saved. (Only the C Select Yes.
Location photos captured with a GPS module have the
location information.)

Protect files

Protect your files from accidental deletion.

In Playback mode, select a file and press [om].
« To unprotect the file, press [0m] again.



Piayback/Editing > S€Arch and manage files

Delete multiple files

You can select multiple files and delete them.

1 In Playback mode, press [4] » Multiple Delete.

« Alternatively, in Playback mode, press [MENU] » (>1 » Delete
» Select.

C Rotate the navigation button or 'Press [Sj,/WB], select files
you want to delete and press [8.3].

* Press [9.'5] again to cancel your selection.

3 Press[%].

U Select Yes.

Delete all files

You can delete all files on the memory card at once.

| In Playback mode, press [MENU].
C Select 33 » Delete » All.

3 Select Yes.



Playback/Editing

Enlarge a photo Start a slide show
You can enlarge photos when viewing them in Playback mode. You can You can view photos in a slide show, apply various effects to the slide
also use the Trim function to extract the portion of the image displayed show, and play background music.

on the screen and save it as a new file.

1 In Playback mode, press [MENU].

Magnified area

Magnification (the maximum
magnification may differ by E Select @

resolution)

3 Select a slide show effect option.
- Skip to step 4 to start a slide show with no effects.

(Option ———Desorpion

Set the photos you want to view as a slide show.
 All: View all photos in a slide show.

- Fullmage ) » Date: View photos captured on a specific date in
Images a slide show.
In Playback mode, turn the jog dial right to enlarge a * Select: View selected photos in a slide show.
P photo. * Sound picture: View voice recorded photos in a
2 ‘/‘ & Tun the jog dial left to reduce a photo. slide show.
. Effect * Select a transition effect.
e Lot + Select Off for no effects.
g . @
Move magnified area Press [AFMF, IS0, o, WBI. Interval Select the amount of time each photo is displayed.
Trim the enlarged image Press [Fn]. (saved as a new file) Music Play background music
Return to the original image Press [?.'ﬁ].

Y Select Slide Show » Play.

/ You can scroll through files by rotating the navigation button, even when a « Slide show begins right away.
photo is enlarged.



Playback/Ediing > VIEW photos

Highlight Auto Rotate
This function identifies the parts of a photo that are excessively bright. With Auto Rotate on, the camera automatically rotates photos you have
When you view a photo with highlight on, the excessively bright areas of taken vertically so they fit the screen horizontally.

the photo blink in blue.

To set auto rotate In Playback mode, press [MENU] > =3 P Auto Rotate P>
options, an option.

Original Highlighted

To set highlight In Playback mode, press [MENU] > 2 » Highlight »
options, an option.




Playback/Editing

You can play a video, capture an image from a video, or crop a video.

» PLAY i

R T

100-0002

ok Pause

+04 Stop

Video viewing controls
o Doths

Press [E,f,].

Rewind Scan backward in 2X,<4X, and 8X increments
each time you press [§].

Pause/Play Press [g].
Press [WB].

Fast forward

Scan forward in 2X, 4X, and 8X increments each
time you press [WB].

Volume control

Scroll the jog dial left or right.

Stop

Press [AF-MF].

Trim a video during playback

1

Press [%] at the point where you want the new video to
begin.

2 When paused, press [®)].

3 Press [%] at the point where you want the new video to

end.

Y When paused, press [@)].

5 Select Yes.

u The cut file is saved as a separate file under a new name.



Playback/Ediing > Play @ video

Capture an image during playback

| Press [%] at the point where you want to save a still
image.

C Press [ISO].

/ * The resolution of the captured image is the same as the video resolution.
¢ The captured file is saved as a separate file under a new name.

N:



Playback/Editing

Perform photo editing tasks, such as resizing, rotating, eliminating red- " Default
eye effects, and adjusting brightness, contrast, or saturation. Edited Option | Descripion |
photos are saved as new files under different file names. Photo Style Selector: Apply various photo styles to photos.
[ 1k I B3 1 = .;;_,- . 5 15 T | 5 ..-: !
To set Image Edit In Playback mode, press [MENU] » =5 » Image Edit > L
options, an option.
Off* Soft Vivid
Options
Cor
* Default ﬂ;l
Option | Doscrption |
(G Red-eye Fix: Remove red-eyes on a photo. (Off*, On)
Backlight: Correct the brightness of an underexposed photo.
(Off*, On)
ﬂ@: Gloomy Classic
Resize: Resize the size of a photo. (Off*, 10M, 6M, 2M)
@F / Available resolutions may differ depending on the size of the
} . selected photo.
Before correction After correction
Rotate: Rotate a photo.
(Off*, Right 90°, Left 90°, 180°, Horizontal, Vertical)
LorF
/ The new file may be smaller than the original.




Playback/Ediing > EAit @ photo

* Default

(option — Descrpion

«(‘ Face Retouch: Hide facial imperfections.
O

FF (Off*, Level 1, Level 2, Level 3)
Smart Filter: Apply various filter effects to photos and create

unique images.
Off* Vignetting Miniature

Fish-Eye Sketch

A

Halftone Dots Soft Focus

a The new file may be smaller than the original.




Camera settings menu

Learn about the user settings and general settings menu.
You can adjust the settings to better suit your needs and preferences.



Camera settings menu

You can set the user environment with these settings.

To set user : :
In Shooting mode, press [MENU] B> & » an option.

ISO Step

You can set the size of the exposure adjustment in fractions of steps.
1/3 step is more subtle than 1 step.

Auto ISO Range

You can set the maximum ISO value under which each EV step is
chosen when you set the ISO Auto.
* Default

1 Step ISO 200, ISO 400, ISO 8007, ISO 1600

ISO 125, ISO 160, ISO 200, ISO 250, ISO 320,
ISO 400, ISO 500, ISO 640, ISO 800*, ISO 1000,
ISO 1250, ISO 1600

1/3 Step

Noise Reduction

Use the Noise Reduction to reduce the visual noise in photos.
* Default

Option ‘ Description

This function reduces noise that may occur when
you set a high ISO sensitivity of more than 3200.
(Off, On*)

High ISO NR

This function reduces noise when you set the
camera for a long exposure (over 1 second).
(Off, On*)

Long Term NR

AF Lamp

When shooting in dark places, turn the AF assist light on in order to
have a better auto focus. The Auto Focus functions more accurately in
dark places when the AF assist light is on.



Camera settings menu > USer settings

User Display

You can add or remove shooting information from the display.

1

M ZUTU/0U/ /U1 2
Londor @
|

* Default

o Dosorpion

1 Icons
Set the shooting options icons on the display on or off.
2 Grid Line
Set the grid on the display on or off. (Off*, 2 X 2, 3 X 3, +, X)
Histogram
Set the histogram on the display on or off.
About histogram
A histogram is a graph that shows the brightness distribution of
a photo. A histogram inclined to the left indicates a dark photo.
A histogram inclined to the right indicates a bright photo. The
3 height of the graph is related to color information. The graph

gets higher if a specific color is more common.

Insufficient exposure Balanced exposure Excessive exposure




Camera settings menu > USer settings

Key Mapping

You can change the function assigned to the AEL and Preview buttons.

* Default

AEL

You can set the AEL button’s function. The AEL and
AFL functions save the exposure value or focus area
respectively when a photo is taken.

You can choose among three settings for the [AEL]

button:

» AEL*, which executes the auto exposure lock function.
When AEL is on, half-pressing the shutter button
executes the auto focus lock function.

* AFL, which executes the auto focus lock function.
When AFL is on, half-pressing the shutter button
executes the auto exposure lock function.

* AEL + AFL, which executes the auto exposure and
focus lock functions together.

Preview

You can assign one of the following functions to the

Depth Preview button:

* One Touch WB (White Balance), which executes the
Custom White Balance function.

» Optical Preview*, which executes the Depth of Field
Preview function for the current aperture value. (p. 19)

¢ One Touch RAW+, which activates or deactivates the
RAW+JPEG feature.




Camera settings menu

Learn about the menu items of the Setting 1

To set Setting 1 . ;
In Shooting mode, press [MENU] B> €% > an option.

* Default

Item ‘ Description

Format the memory card. Formatting prepares a memory
card for use in the camera and deletes all existing files
including protected files. (No, Yes)

Errors can occur if you use a memory card formatted
by another brand of camera, a memory card reader, or
a computer. Please format memory cards in the camera
before using them to capture photos.

Format /

Reset the setup menu and shooting options to the factory
Reset defaults. (Date, time, language, and video output settings
do not change.) (No, Yes)

Set the method of creating file names.
» Standard*: SAM_XXXX.JPG(sRGB)/
_SAMXXXX.JPG(Adobe RGB)
* Date:
- sRGB files - MMDDxxxx.JPG. For example, for a photo
) taken on Jan. 01, the file name would be 0101xxxx.jpg.
File Name - AdobeRGB files - MDDxxxx.JPG for the months Jan
through Sept. For the months Oct through Dec, the
month number is replaced by the letters A (Oct.), B
(Nov.) and C (Dec.).
For example, for a photo taken on Feb. 03, the file name
would be 203xxxx.jpg. For a photo taken on Oct. 05,
the file name would be A05xxxx.jpg.

File Number

* Default

Set the method of numbering files and folders.

» Series™: New file numbers continue the existing number
sequence, even if you have installed a new memory
card, formatted the card, or deleted all photos.

* Reset: After using the reset function, the next file name
is started at 0001.

* The first folder name is 100PHOTO, if you have
/ selected the sRGB color space and Standard file

naming, the first file name is SAM_0001.

* File name numbers are increased by 1 from SAM_0001
to SAM_9999.

* Folder numbers are increased by 1 from 100PHOTO to
999PHQOTO.

¢ The maximum number of files that can be saved in one
folder is 9999.

* File numbers are assigned according to DCF (Design
rule for Camera File system) specifications.

* |f you change a file name (for example, on a computer),
the camera will not be able to play the file.

Folder Type

Set the type of folder.
» Standard*: XXXPHOTO
* Date: XXX_MMDD

Language

Select the language the camera shows on the display.




Camera settings menu

Learn about the menu items of the Setting 2.

To set Setting 2 . .
In Shooting mode, press [MENU] B> €3 » an option.

* Default

Item ‘ Description

Set the Quick View time length — the amount of time the
Quickview camera displays a photo immediately after you take it.
(Off, 1 sec”, 3 sec, 5 sec, Hold)

Adjust the display brightness, auto brightness setting, or

display color.

 Display Brightness: You can adjust the display
brightness by rotating the navigation button or using

Display [AF-MF/ISO0].
Adjust * Auto Brightness: Turn auto brightness on or off. (Off,
On®)

* Display Color: You can adjust the display color by
rotating the navigation button and using [AF-MF/1S0/
2 /WB|
ﬂ_d' .

Set the display off time. The display turns off if you do not
Display Save | use the camera for the time you set.
(Off, 0.5 min*, 1 min, 3 min, 5 min, 10 min)

* Default

Set power shut off time. The camera shuts off if you do
not use it for the time you set. (0.5 min, 1 min*, 3 min, 5
min, 10 min, 30 min)

Power Save / ¢ The camera retains the power-off time setting even if
you replace the battery.
¢ Power save may not work if the camera is connected
to a computer, TV, or printer, playing a slide show or
movie.
Set date, time, date format, time zone and whether to
imprint the date on photos. (Type, Date, Time Zone,
Time, Imprint)
¢ The date and time are displayed either in 12h or 24h
Date & Time / format.
¢ The date appears on the lower right side of the
photo.
* When you print a photo, some printers may not print
the date appropriately.
» System Volume: Set the sound volume or turn all
sound off entirely. (Off, Low, Medium*, High)
Sound * AF Sound: Set the sound the camera makes in AF

mode on or off. (Off, On*)

e Button Sound: Set the sound the camera makes when
you press buttons on or off. (Off, On*)




Camera settings menu

Learn about the menu items of the Setting 3.

To set Setting 3 . :
In Shooting mode, press [MENU] B> €% » an option.

* Default

Item ‘ Description

* Sensor Cleaning: Remove dust from the sensor.
 Start-Up Action: When on, the camera performs
sensor cleaning each time you turn it on. (Off*, On)

As this product uses interchangeable lenses, the
’ / sensor can get dust on it when you change lenses.
Cleaning This can lead to dust particles appearing in the photos
you take. It is recommended not to change lenses
when you are in a particularly dusty area. Also, make
sure to attach the lens cap to the lens when not using
it.

Sensor

Select the video output signal appropriate for your
country when connecting the camera to an external video
device such as a monitor or TV.

* NTSC*: US, Canada, Japan, Korea, Taiwan, Mexico
Video Out * PAL (Supports only PAL B, D, G, H, or I):Australia,
Austria, Belgium, China, Holland, Finland, Germany,
England, ltaly, Kuwait, Malaysia, New Zealand,
Singapore, Spain, Sweden, Switzerland, Thailand,
Norway

* Default

Anynet+
(HDMI-CEC)

When you connect the camera to an HDTV that supports

Anynet+ (HDMI-CEC), you can control the play function of

the camera with the TV remote control.

* Off: You cannot control the play function of camera
with the TV remote control.

* On*: You can control the play function of camera with
the TV remote control.

HDMI Size

When you connect the camera to an HDTV with an HDMI
cable, you can change the resolution of the image.

* NTSC: Auto*, 1080i, 720p, 480p

* PAL: Auto*, 1080i, 720p, 576p

If the connected HDTV does not support the resolution
/ you select, the camera sets the resolution one level
lower.
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* Default

rom " pesorpion

Firmware
Update

Display the firmware version of the camera body and

lens, and update the firmware.

* Body Firmware: Update the firmware of the camera
body.

* Lens Firmware: Update the firmware of the lens.

* You can download firmware upgrades from
a WWW.Samsungimaging.com or www.samsung.com.

* You cannot run a firmware upgrade without a fully
charged the battery. Recharge the battery fully before
running a firmware upgrade or attach the adapter to
provide power (optional).

* |f you update the firmware, user settings values will be
reset. (Date, time, language, video out will not change.)

* Do not turn the camera off while the update is in
progress.
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Camera settings menu

Learn about the menu items of the Setting 4. You should purchase an
optional GPS accessory in order to use the GPS function.

To set Setting 4 . ;
In Shooting mode, press [MENU] B> €& » an option.

* Default

Set to take photos with location information using the
Global Positioning System (GPS). Location information
is added to the Exif data associated with the photo.
(Off, On%)

GPS Valid Time Set the time tq use the !ast Iocatpn information when
the camera fails to receive GPS signals.

GeoTagging

Settings (15 sec*, 30 sec, 1 min, 3 min, 10 min, 30 min)
Set to display the location information on the top right
screen of Shooting mode. The location information
Location will appear in Korean only when you are in Korea and — -
Display the display language is set to Korean. When another W Hﬂﬂ E‘i 0O E‘Ju [
language is set, the location information will appear in =00 \hﬁi fa’jm E
English. (Off, O’ il gl@? 0 ﬁ’
- Fﬁa\ N NN (e
GPS Reset Set to search for GPS satellites closest to your current sk @ (7 ‘@ [Ir

position. (No, Yes)
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Camera settings menu

Learn about the menu items of the Setting 5.

To set Setting 5 . :
In Shooting mode, press [MENU] B> €% B> an option.

* Default

ltem ‘ Description

Distortion
Correct

Correct lens distortion that might occur from lenses.
This feature may not be available with some lenses.
(Off*, On)

Lens i-Function

Set the functions to be displayed when you press
[iFn] on an iFn lens.

» WB: Off, On*
 1SO: Off, On*




Connect to external devices

Make full use of the camera by connecting it to external devices such as a computer, TV, or photo printer.



Connect to external devices

Play back photos or videos by connecting your camera to a TV using Y Make sure the TV and the camera are turned on and then
the A/V cable. select the video input mode or source (AV or AV1 for
example) of the TV.

5 View the videos and photos using the buttons on the

View filesona TV
camera.

1 In Shooting mode or Playback mode, press [MENU] »

» Video Out. / * On some TVs, digital noise may occur or part of an image may not appear.
* Images may not appear centered on the TV screen depending on your TV

C Select a video signal output according to your country or seffinge.
N 9 HipY ng fo you untry * You cannot capture photos or videos while the camera is connected to a

region. (p. 95) V.

3 Connect the TV and the camera using the A/V cable.

Video Audio
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View files on an HDTV

| In Shooting or Playback mode, press [MENU] » ¢ »
HDMI Size » an option.

C Connect the HDTV and the camera using the HDMI cable.

/ If both A’V and HDMI cables are connected at the same time, the HDMI
cable has the priority. Disconnect the A/V cable for better playback.

3 Make sure that the HDTV and camera are turned on, and
then select the HDMI mode.

« The HDTV screen mirrors the camera's display.

Y View the videos and photos using the buttons on the
camera.

using the Anynet+(CEC) method.

The Anynet+(CEC) functions allow you to control connected devices using

the TV remote control.

* |f the HDTV supports Anynet+(CEC), the TV turns on automatically when
used in conjunction with the camera. This feature may not be available on
some HDTVs.

* When connected to an HDTV by an HDMI cable, the camera cannot take a
photo or video.

* When connected to an HDTV, some of the camera’s playback functions
may not be available.

* The length of time after which the camera and an HDTV are connected
may vary depending on the SD card that you are using.

* As the main feature of an SD card is to increase the transfer speed, it is not
necessarily true to say that an SD card with a faster transfer speed is also
fast in using the HDMI function.

a * When using the HDMI cable, you can connect the camera to an HDTV



Connect to external devices

Print photos on your camera by connecting to printers directly or saving 2 Turnon your camera.
Digital Print Order Format (DPOF) information on a memory card. .« Select Printer in the pop-up window

/ If your printer has the mass storage feature, you must first set the USB
mode to Printer in the settings menu.

Print photos with a photo printer
(PictBridge)

You can print photos with a PictBridge-compatible printer by connecting
your camera directly to the printer.

3 Press [S’__.,/ WB] to select a photo.
« Press [MENU] to set printing options.

Y Press [3.'5] to print.

| With the printer on, connect your camera to the printer
with the USB cable.
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Set printer info using DPOF

@ AL DPOF (Digital Print Order Format) lets you set the print size of a photo
and the number of copies to be printed. The camera saves the DPOF

; information in the MISC folder of your memory card. Your camera

Size Auto displays a DPOF indicator when it displays an image with DPOF

Layout Auto information. If you have set DPOF information for your images, you can
Type Auto take the memory card to a digital printing shop for printing.

Quality Auto

Date Auto To set DPOF In Playback mode, press [MENU] » =3 » DPOF b
B Print JMENUS Exit options, select an item.

Option ‘ Description

Images Select whether to print the current photo or all
photos.

Size Specify the size of the print.

Layout Create thumbnail prints.

Type Select the type of paper.

Quality Set the printing quality.

Date Set to print the date.

File Name Set to print the name of the file.

Reset Reset the print options.

a Some options are not supported by some printers.
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DPOF options
Opton ——_ Doserption |

You can select photos to print and the number of copies

for photos.

e Select: Select the number of copies for photos you
select. (Select photos you want to print B Select the
number of copies by scrolling the jog dial left or right
and then pressing [Fn])

* All: Select the number of copies for all photos. (Select
the number of copies by pressing [AF-MF/IS0] and
then, press [%]).

* Reset: Cancel all DPOF printing quantity selections.

Standard

This option lets you print all photos set to be printed as

Index thumbnails in a single paper.

You can specify the size of the print.

» Select: Select the print size for photos you choose.
(Select photos you want to print B Select the print size
by scrolling the jog dial left or right and then pressing

Size [Fn])

* All: Select the print size of all the photos saved in
the memory card. (Select the print size by pressing
[AF-MF/ISO] and then, press [fg])

* Reset: Cancel the DPOF print size for all photos.




Connect to external devices

Transfer files on a memory card to your computer by connecting the
camera to the PC.

Transfer files to your computer
(for Windows)

Transfer files by connecting the camera as a removable disk

You can connect the camera to your computer as a removable disk.

1 Turn off the camera.

Z Connect the camera to your computer with the USB
cable.

¢ You must plug the end of the cable with the correct connection plug
into your camera. If the cable is reversed, it may damage your files.
The manufacturer is not responsible for any loss of data.

¢ If you try to plug the USB cable into the HDMI port, the camera may
not work properly. If it occurs, restart the camera.

3 Turn on the camera.
* In the pop-up window, select Computer.

Y On your computer, select My Computer » Removable
Disk » DCIM » XXXPHOTO or XXX_MMDD.

5 Select the files you want, and then drag or save them to
your computer.

If the Folder Type is set to Date, the folder name appears as “XXX_MMDD.”
/ For example, if you capture a photo on January 1, the folder name will be
"101_0101".
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Disconnect the camera (Windows XP)

The way to disconnect the USB cable for Windows Vista and 7 is
similar.

| Ensure that no data is being transferred between the
camera and the PC.
« If the status lamp on your camera is blinking, it means the data

transfer is in progress. Please wait until the status lamp stops
blinking.

C Click ! on the tool bar at the bottom right of your PC
screen.

60 F ¢ 10:00 AM

3 Click the pop-up message.
Y Click the message box indicating safely removed.

5 Remove the USB cable.

Transfer files to your computer (for Mac)

1 Turn off the camera.

€ Connect your camera to a Macintosh computer with the
USB cable.

a Mac OS 10.4 or later is supported.

* You must plug the end of the cable with the correct connection plug
& into your camera. If the cable is reversed, it may damage your files.
The manufacturer is not responsible for any loss of data.
* |f you try to plug the USB cable into the HDMI port, the camera may
not work properly. If it occurs, restart the camera.

3 Turn on the camera.
« In the pop-up window, select Computer.

Y Double-click the removable disk icon.

5 Transfer photos or videos to the computer.
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Digital photos can be edited in a variety of ways through image editing
programs. Learn to edit photos using the provided editing programs.

Install software

Use the included software to transfer files from the camera to your PC.

You can also edit photos and upload them on web.

| Insert the CD-ROM into your PC.

£ When the setting wizard appears, click Samsung Digital
Camera Installer.

3 Select a program you want to install and click Install.
Y Follow the on-screen instructions.

5 When the installation is complete click Exit.

Programs contained on the CD

Intelli-studio Edit photos and videos.

Convert RAW files into the desired file

Samsung RAW Converter format.

* |f your computer does not meet the requirements, videos may not play
/ correctly or it may take longer to edit videos.
¢ Install DirectX 9.0c or above before you use the program.
* You must use Windows XP/Vista/7 or Mac OS 10.4 or later to connect the
camera as a removable disk.

Using a self-assembled PC or a PC and OS that are not supported may void
your warranty.

Use Intelli-studio

Intelli-studio is a built-in program that allows you to play back and edit
files. You can also upload files to your favorite websites. For details,
select Help » Help in the program.
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System Requirements Use the Intelli-studio Interface
fom [ Roquiements | 2 3 4 5 & 7

os* Windows XP SP2/Vista/7
Intel® Pentium® 4, 3.2GHz or higher/AMD Athlon™

CPU FX, 2.6GHz or higher
RAM Minimum 512MB RAM (1GB and above T T g
g =l W [
Hard disk capacity | 250MB or more (1GB or more recommended) ':’;"m ——_— :wm_m gyl oo
& (3 Desnp g
+ CD-ROM drive i [ ;
+ 1024x768 pixels, 16-bit color display compatible T — we 9
monitor (1280x1024 pixels, 32-bit color display e 3 100rmoro
e USB 2.0, Microsoft DirectX 9.0c or later i )
* nVIDIA Geforce 7600GT or higher/ATI X1600 0 30070 ERnsonrs BRI R

series o Nl I e —
* B4-bit editions of Windows XP, Vista, and 7 are not supported.
No [Doscrption

Open menus.

¢ Intelli-studio may not perform correctly on some computers, even when the
& computer meets the requirements.
¢ Intelli-studio is compatible only with Windows.
¢ You cannot edit files directly on the camera. Transfer files to a folder on
your computer before editing.
* You cannot copy files in your computer to the camera.
¢ Intelli-studio supports the following formats:
- Videos: MP4 (Video: H.264, Audio: AAC), WMV (WMV 7/8/9), AVI
(MJPEG)
- Photos: JPG, GIF, BMP, PNG, TIFF
¢ You cannot open the RAW format files with the Intelli-studio program.

Display files in the selected folder.

Change to the Photo edit mode.

Change to the Video edit mode.

Change to the Sharing mode. (You can send files by email or
upload files to websites, such as Flickr or YouTube.)

Enlarge or reduce the thumbnails in the list.

N o OB -

Select a file type.
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O * Covrect e camra o your Gomputer i e USE

View files of the selected folder on your computer. cable.

9 Show or hide files of the connected camera.

10 | View files of the selected folder on the camera.

11 | View files as thumbnails, in Smart Album, or on a map.

12 | Browse folders in the connected device.

13 | Browse folders in your computer.

14 | Move to the previous or next folder.

15 Print files, view files on a map, store files in My Folder, or register ii * You must plug the end of the cable with the correct connection plug
faces. into your camera. If the cable is reversed, it may damage your files.
The manufacturer is not responsible for any loss of data.
* If you try to plug the USB cable into the HDMI port, the camera may
not work properly. If it occurs, restart the camera.

Transfer files using Intelli-studio

You can easily transfer files on your camera to your computer by using ) )
Intelli-studio. 3 Run Intelli-studio on your computer.

1 Turn off the camera. Y Turn on the camera.
« In the pop-up window, select Computer.

5 Select a folder on your computer to save new files and
select Yes.

» New files will be transferred to the computer.

« If your camera has no new files, the pop-up window for saving
new files will not appear.
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Use Samsung RAW Converter

Photos captured by a camera are often transformed to JPEG formats
and stored in the memory according to the settings of the camera at
the time of shooting. RAW files are not transformed to JPEG formats
and are stored in the memory without any changes. With Samsung
RAW Converter, you can calibrate exposures, white balances, tones,
contrasts, and colors of photos.

System Requirements for Windows

Microsoft® Windows® XP / Vista / 7

0S * Administrator rights are needed for installation.

* The program runs as a 32-bit application under the 64-bit
OS.

Intel Pentium®, AMD Athlon processor-based PC or

compatible computer (Pentium4, Athlon XP or later

CPU recommended)

* Multi-core processor ready (Intel Core i7,Core 2 Quad, Core
2 Duo, AMD Phenom IIX4, Phenom X4, etc.)

RAM 1GB or more recommended

Please reserve at least 100MB of space. Please
allocate sufficient disk space for image storage.
(One image may use more than 10MB of disk
space.)

* XGA (1024x768), Full Color (24 bit or higher)
» Keyboard, mouse, or equivalent devices

Hard disk capacity

Others

System Requirements for Mac

0S Apple® Mac® OS X v10.4 /v10.5/v10.6

Intel processor-based or compatible computer

CPU (Core 2 Quad or later recommended) / PowerPC

RAM 1GB or more recommended

Please reserve at least 100MB of space. Please
allocate sufficient disk space for image storage.
(One image may use more than 10MB of disk
space.)

* XGA (1024x768), Full Color (24 bit or higher)
* Keyboard, mouse, or equivalent devices

Hard disk capacity

Others

* Samsung RAW Converter may not perform correctly on some computers,
/ even when the computer meets the requirements.
* The Mac installation program will not autorun. Please manually run the
setup file on the provided CD-ROM.
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Use the Samsung RAW Converter Interface Edit RAW format files

For details about using Samsung RAW Converter, click Help » If you edit the RAW format files with the Samsung RAW Converter,
Open software manual. you can maintain high image quality. You can also edit JPEG and TIFF
format files.
1
2 - -
To adjust the exposure of an image
3 1 Select File » Open file and open a file.
Z From the editing tools, select (4.
4

Menu
Toolbar

Editing tools

o Dosorpion
1

2

3

4

Open/Close the fine adjustment window for the editing tools.
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3 Adjust the exposure with the scroll bar. To adjust the contrast of an image

| Select File » Open file and open a file.
2 From the editing tools, select @).

3 Adjust the tone with the scroll bar.

Original image Edited image
P Mode, Aperture: f=8,
Shutter Speed: 1/15 sec, ISO=100

Original image Edited image

Original image Edited image
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To save RAW files in JPEG or TIFF formats

| Select File » Open file and open a file.
C Select File » Development.

3 Select a file format (JPEG or TIFF) and select Save.
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When the following error messages appear, try these remedies.

Error messages ‘ Suggested remedies

The lens is locked. Rotate the lens counter-
clockwise until you hear a click. (p. 32)

Lens is locked

» Turn off your camera and then turn it on again.
* Remove your memory card and insert it again.
* Format your memory card.

Card Error

Low Battery Insert a charged battery or recharge the battery.

Take photos or insert a memory card that contains

No Image File photos.
File Error Delete the damaged file or contact a service center.
Memory Full Delete unnecessary files or insert a new memory

card.

You can lock SD or SDHC card to prevent files from
being deleted. Unlock the card when shooting.
(p- 117)

Card Locked

File names do not match the DCF standard. Transfer
the files on the memory card to your computer and
format the card. (p. 93)

DCF Full Error

Turn off your camera and remount the lens. If the

Error 00 message still appears, contact a service center.
Turn off your camera, remove the battery and insert
Error 01/02 again. If the message still appears, contact a service

center.
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Appendix

Clean the camera

Depending on different shooting conditions, dust may appear in photos

because the image sensor is exposed to the external environment.
This problem is normal, and the exposure to dust occurs in everyday

Use a brush to remove dust and wipe the lens gently with a soft cloth. If use of the camera. You can remove dust from the sensor by operating

any dust remains, apply lens cleaning liquid to a piece of cleaning paper the sensor cleaning function. (p. 95) If dust remains after cleaning

and wipe gently. the sensor, contact a service center. Do not insert the blower into the

mounting opening of the lens.

Camera body

Wipe gently with a soft and dry cloth.

/ Never use benzene, thinners or alcohol to clean the device. These solutions
can damage the camera or cause it to malfunction.
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About memory card Memory card capacity

The memory capacity may differ depending on shooting scenes or

Supported memory card shooting conditions. These capacities are based on a 1 GB SD card.
You can use SD or SDHC memory cards. Size | Fine | Normal
1280 (16:9) | Approx. 15 min Approx. 22 min
Termlnal—[ EDDDDDD] (f\sltl)dsgfsec) 640 (4:3) Approx. 44 min Approx. 66 min
¥ 320 (4:3) Approx. 145 min Approx. 210 min
Write-protect switch A

* The recordable time may vary if you use the zoom. Several videos were recorded in

succession to determine the total recording time.
Label (front) o

You can prevent files from being deleted by using the write-protect
switch on an SD or SDHC card. Slide the switch down to lock or slide it
up to unlock. Unlock the card when capturing photos and videos.
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‘ Super Fine Normal RAW RAW + S.Fine| RAW + Fine RAW + Normal
14M 4592X3056 (3:2) 141 282 423 34 25 30 32
10M 3872X2592 (3:2) 195 391 587 - 28 34 35
6M 3008X2000 (3:2) 320 640 961 - 31 37 38
2M 1920X1280 (3:2) 732 1,465 2,198 - 35 42 42
Burst 1,161 2,322 3,484 - - - -
12M 4592X2584 (16:9) 166 332 499 - 26 32 33
Photo 8M 3872X2176 (16:9) 232 464 696 - 29 35 36
5M 3008X1688 (16:9) 376 752 1,129 - 32 38 39
2M 1920X1080 (16:9) 850 1,703 2,550 - 36 42 42
9M 3056X3056 (1:1) 210 420 630 - 32 34 35
6.7M 2592X2592 (1:1) 288 576 864 - 34 37 37
4M 2000X2000 (1:1) 470 940 1,411 - 38 40 40
1.6M 1280X1280 (1:1) 1,041 2,083 3,121 - 42 43 43
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Use only Samsung-approved batteries.

Battery specifications

Model BP1310

Type Lithium-ion battery
Cell capacity 1,300 mAh
Voltage 7.4V

Charging time _
(when the camera is switched off) Approx. 150 min

Battery life

Shooting mode ‘ Average time / Number of photos
Photos Approx. 210 min/Approx. 420 photos
Videos Approx. 130 min

« The figures above are based on Samsung’s test standards. Your
results may differ depending on your actual usage.

+ Available shooting time differs depending on background, shooting
interval, and use conditions.

« Several videos were recorded in succession to determine the total
recording time.
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Notes about charging the battery

If the indicator light is off, make sure that the battery is inserted
correctly.

When the battery is completely discharged, charge it at least 10
minutes before using it with your camera.

Using the flash or recording videos depletes the battery more quickly.
Charge the battery until the indicator light turns green.

If the indicator light blinks orange or does not illuminate, reconnect the
cable, or remove the battery and insert it again.

If you charge the battery when the cable is overheated or the
temperature is too high, the indicator light may turn orange. Charging
will start when the battery cools down.

Do not pull on the power supply cord to disconnect the plug from the
power outlet. This may cause a fire or electric shock.

Do not bend or place heavy objects on the AC cable. Doing so may
damage the cable.

Personal injury or death can occur if the battery is handled carelessly or
improperly. For your safety, follow these instructions for proper battery
handling:

The battery can ignite or explode if not handled properly. If you notice

any deformities, cracks, or other abnormalities in the battery, immediately
discontinue use of the battery and contact your manufacturer.

Use only authentic, manufacturer-recommend battery chargers and
adapters and charge the battery only by the method described in this user
manual.

Do not place the battery near heating devices or expose to excessively
warm environments, such as the inside of an enclosed car in the
summertime.

Do not place the battery in a microwave oven.

Avoid storing or using the battery in hot, humid places, such as spas or
shower enclosures.

Do not rest the device on flammable surfaces, such as bedding, carpets,
or electric blankets for a prolonged period.

When the device is switched on, do not leave it in any confined space for a
prolonged period.

Do not allow battery terminals to come in contact with metallic objects,
such as necklaces, coins, keys, or watches.
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¢ Use only authentic, manufacturer-recommended, Lithium-ion replacement
batteries.

* Do not disassemble the battery or puncture the battery with any sharp
object.

¢ Avoid exposing the battery to high pressure or crushing forces.

¢ Avoid exposing the battery to major impacts, such as dropping it from high
places.

¢ Do not expose the battery to temperatures of 60 °C (140 °F) or above.

¢ Do not allow the battery to come in contact with moisture or liquids.

¢ Battery shall not be exposed to excessive heat such as sunshine, fire or the
like.

Disposal guidelines

¢ Dispose of the battery with care.

¢ Do not dispose of the battery in a fire.

¢ Disposal regulations may differ by country or region. Dispose of the battery
. . . s
in accordance with all local and federal regulations. ~ 5

Guidelines for charging the battery

|
|

Charge the battery only by the method described in this user manual. The =

battery can ignite or explode if not charged properly. @“ @
an
~
(0 *
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If you are having trouble with your device, try these troubleshooting
solutions before contacting a service professional.

/ Give other accessories, such as memory card and battery when requesting a
warranty service.

Situation ‘ Suggested remedies

Cannot turn on the
camera

Make sure that the battery is inserted.

Make sure that the battery is inserted
correctly.

Charge the battery.

The power turns off
suddenly

Charge the battery.

Your camera may be in Power save mode.

(0. 94)

The camera may be turned off automatically
to prevent the memory card from being
damaged due to excessive heat. Turn on your
camera again.

Cannot take photos

Situation ‘ Suggested remedies

» There is no space on the memory card.
Delete unnecessary files or insert a new card.

* When the AF Priority function is turned on,
you cannot take a photo unless the focus is
set correctly. Set AF Priority to Off or focus
on the subject correctly. (p. 63)

* Format the memory card.

* The memory card is defective. Get a new
memory card.

* The memory card is locked. Unlock the card.
(p. 117)

* Make sure that the camera is switched on.

* Charge the battery.

* Make sure that the battery is inserted
correctly.

The camera freezes

Remove the battery and insert it again.

The camera is losing
battery power quickly

The battery may lose power more quickly

in low temperatures (below 0° C). Keep the
battery warm by putting it into your pocket.
Using the flash or recording videos depletes
the battery quickly. Recharge if needed.
Batteries are consumable parts that must be
replaced over time. Get a new battery if the
battery life is diminishing quickly.

The camera heats up

While using the camera, it may heat up. This
is normal and should not affect your camera’s
lifespan or performance.

The date and time are
incorrect

Set the date and time in the display settings
menu.

The display or
buttons do not work

Remove the battery and insert it again.

The memory card has
an error

The memory card has not been formatted or
has become corrupt. Format the card.
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Situation ‘ Suggested remedies

Cannot display files

If you change the name of a file, your camera
may not play the file (the name of the file should
meet the DCF standard). If you encounter this
situation, display files on your computer.

The photo is blurry

* Make sure that the focus option you set is
suitable for the kind of shot you are taking.

» Use a tripod to prevent your camera from
shaking.

* Make sure that the lens is clean. If not, clean
the lens. (p. 116)

Photos are distorted

Situation ‘ Suggested remedies

This camera can have minute distortion when
using a wide-angle lens that enables shooting
with a wide angle of view. This is normal, and
does not cause malfunction.

Playback screen does
not appear on the
connected external
device

* Make sure that A/V or HDMI cable is properly
connected to the external monitor.

* Make sure that the memory card is properly
recorded.

The colors in the
photo do not match
the actual scene

An incorrect white balance can create unrealistic
color. Select the proper white balance option to
suit the light source. (p. 53)

The photo is too
bright

Your photo is overexposed.

» Adjust the aperture value or the shutter
speed.

» Adjust the exposure value. (p. 75)

Your computer does
not recognize your
camera

* Make sure that the USB cable is connected
correctly.

* Make sure that your camera is switched on.

* Make sure that you are using a supported
operating system.

The photo is too dark

Your photo is underexposed.

» Adjust the aperture value or the shutter
speed.

» Adjust the exposure value. (p. 75)

 Turn on the flash. (p. 35)

Your computer
disconnects the
camera while
transferring files

The file transfer may be interrupted by static
electricity. Disconnect the USB cable and
connect it again.

Your computer
cannot play videos

Depending on the software you use, video files
may not play. To play video files captured with
your camera, install and use the Intelli-studio
program on your computer.

Cannot set the DPOF
for RAW files

You cannot set the DPOF for RAW files.
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Situation ‘ Suggested remedies

Auto Focus does not
work

* Subject is not in focus. When the subject is
outside the AF area, shoot by moving the
subject inside the AF area and half pressing
the shutter.

* Subject is too close. Step back from the
subject and shoot.

* The focus mode is set to MF. Switch the
mode to AR

AEL feature does not
work

AEL feature does not work in M, @, SCENE,
and @eiarr Modes. Select another mode to use
this feature.

A built-in lens does
not work

Make sure the lens is properly mounted.
Remove the lens from the camera and re-mount
it.

External flash, GPS,
electronic viewfinder
does not work

Make sure that the external device is properly
mounted and turned on.

The date & time
settings screen
appears when you
power on the camera

» Set the date and time again.

* This screen appears when the camera’s
internal power source is completely
discharged. Insert a fully charged battery and
wait at least 72 hours in power off status for
the internal power source to be recharged.
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Image Sensor
Type CMOS

Sensor size 23.4 x 15.6 mm

Effective pixels Approx. 14.6 mega-pixels

Total pixels Approx. 15.1 mega-pixels

Color filter RGB primary color filter

Lens Mount

Type Samsung NX Mount

Available lens Samsung lenses

Image Stabilization
Type Lens shift (depends on lens)
Mode OIS mode1 / mode2

Distortion Correct

LLens Distortion Correct on/off (depends on lens)

Dust Reduction

Super sonic drive

Display

Type AMOLED

Size 3.0"

Resolution VGA (640x480) 614 k dots (PenTile)

Field of view Approx. 100 %

User display Icon, Grid, Histogram

Viewfinder

Type EVF (Electronic Viewfinder) (optional)
Resolution QVGA Approx. 201 k dots (300X224)
Field of view Approx. 98 %

Magnification Approx. 0.83X (APS-C, 50 mm, -1 m)
Eye point Approx. 17 mm

Diopter adjustment

Approx. -4.0 ~+1.0m""

Focusing

Type

Contrast AF

Focusing point

» Selection: 1 point (free selection)
e Multi: Normal 15 points,

Close up 35 points
» Face detection: Max. 10 faces

Mode

Single Auto Focus, Continuous Auto Focus,
Manual Focus

AF Assist Lamp
Shutter

Green LED

Electronically controlled vertical-run focal

Type plane shutter
* Auto: 1/4000 s ~ 30 s
Speed e Manual: 1/4000 s ~ 30 s (1/3 EV step)

* Bulb (time limit: 8 min)




appendix > GCamera specifications

Metering system

Exposure

TTL 247 (19x13) Block segment

Metering: Multi, Center-weighted, Spot

Metering range: EV O ~ 18
(1ISO100-30 mm, F2)

Compensation

+3 EV (1/3 EV step)

AE lock

AEL button

ISO equivalent

* Auto, ISO 100, ISO 200, ISO 400,
ISO 800, ISO 1600, ISO 3200
(1 or 1/3 step)

* |ISO expansion: up to ISO 6400

Mode

Single, Continuous, Burst, Timer, Bracket
(auto exposure, white balance, picture
wizard)

Continuous shooting

* JPEG: 3 shots per second
(Max. 6 shots-LDC on,
Max. 10 shots-LDC off)

* RAW: 3 shots per second

Burst shooting

* 10, 15, or 30 frames per second
* 30 shots per shutter-press

Bracket shooting

Auto exposure bracket (=3EV),
White Balance Bracket,
Picture Wizard Bracket

Self-timer

2 ~ 30 s (1 second interval)

Shutter release

SRIONXO01 (optional)

Flash

External flash

Optional Samsung external flashes:
SEF15A, SEF20A, SEF42A

Syncro
White Balance

Accessory shoe (Hot shoe)

Mode

Auto WB, Daylight, Cloudy,

Fluorescent White, Fluorescent NW,
Fluorescent Daylight, Tungsten, Flash WB,
Custom Set, Color Temp. (Manual)

Micro adjustment

Amber/Blue/Green/Magenta
7 steps respectively

Dynamic Range Expansion
Smart range on/off
Picture Wizard

Standard, Vivid, Portrait, Landscape, Forest,

Mode Retro, Cool, Calm, Classic, Custom1,
Custom?2, Custom3
Parameter Contrast, Sharpness, Saturation, Color

Shooting

Smart Auto, Lens Priority, Program,

Mode Shutter Priority, Aperture Priority, Manual,
Scene, Movie
Beauty Shot, Children, Sports, Close Up,
Text, Sunset, Dawn, Backlight, Fireworks,
Scene mode

Beach & Snow, Night, Portrait, Landscape,
Sound picture
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Sound picture

JPEG only

Recordable time (before and after shooting,
5 or 10 seconds respectively)

* JPEG (3:2): 14M (4592x3056),
10M (3872x2592), 6M (3008x2000),
2M (1920x1280), 1.4M (1472x976,
Burst mode only)

* JPEG (16:9): 12M (4592x2584),

Size 8M (83872x2176), 5M (3008x1688),
2M (1920x1080)

* JPEG (1:1): 9M (3056x3056),
6.7M (2592x2592), 4M (2000x2000),
1.6M (1280x1280)

* RAW: 14M (4592x3056)

Quality Super Fine, Fine, Normal
RAW standard SRW
Color space sRGB, Adobe RGB
Type MP4 (H.264)
Format Movie: H.264, Sound: AAC
Movie AE mode Program, Aperture Priority
Movie cli Audio on/off

P (Shooting time: up to 25 min)
Size 1280x720, 640x480, 320x240
Frame rate 30 frames per second

Sound

Mono

Edit
Playback

Type

Still image capture, Time trimming

Single image, Thumbnails (3/9/20), Slide
show, Movie

Highlight warning

Available

Edit

Red-eye Fix, Backlight, Photo Style Selector,
Resize, Rotate, Face Retouch, Smart Filter

Smart filter

Vignetting, Miniature, Fish-Eye, Sketch,
Defog, Halftone Dots, Soft Focus

Smart filter size

« JPEG (3:2): 6M (3008x2000),
2M (1920x1280), VGA (640x424)
« JPEG (16:9): 5M (3008x1688),
2M (1920x1080), VGA (640x360)
« JPEG (4:3): 6M (3008x2256),
2M (1920x1440), VGA (640x480)
« JPEG (1:1): 4M (2000x2000),
1.6M (1280x1280), VGA (480x480)

Photo style selector

Storage

Soft, Vivid, Forest, Autumn, Misty, Gloomy,
Classic

External memory (optional): SD card

Media (up to 4 GB guaranteed), SDHC card
(up to 32 GB guaranteed)
File format RAW (SRW), JPEG (EXIF 2.21), DCF,

DPOF 1.1, PictBridge 1.0
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Direct Printing
PictBridge

GPS

oo Geo-tagging with optional GPS Module
yp (WGS 84)

* Location name (English and Korean only)

Feature * Google Map link (with Intelli-studio)

Interface

Digital output USB 2.0 (HI-SPEED)

NTSC, PAL (selectable)
HDMI 1.3: (1080i, 720p, 576p/480p)

Included
DC 9.0V, 1.5A (100 ~ 240 V)

Video output

External release

DC power input

Power Source

* Rechargeable battery: BP1310
(1300 mAh)

Type e Charger: BC1310
* AC adapter: ADONXO1 (optional)
* The power source may differ depending
on your region.

Dimensions (WxHxD)

120.5 x 71 x 34.5 mm (without protrusions)
Weight
282 g (without battery and memory card)

Operating Temperature
0~40°C

Operating Humidity
5~85%

Software

Intelli-studio, Samsung RAW Converter

* This specifications can change without notice to upgrade a performance.
* Other brands and products names are trademarks of respective owners.
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Lens Name

Focus Length

| SAMSUNG 20-50 mm F3.5-5.6 ED
20 ~ 50 mm (equivalent to 30.8 ~ 77 mm in 35 mm format)

| SAMSUNG 20 mm F2.8
20 mm (equivalent to 30.8 mm in 35 mm format)

Elements in Group

9 elements in 8 groups
(1 aspheric lens, 1 low dispersive lens included)

6 elements in 4 groups
(1 aspheric lens included)

Angle of View 70.2° ~ 31.4° 70.2°

Aperture F3.5 ~5.6 (minimum: F22), . F2.8 (minimum: F22), . .
(Number of Blades: 7, Circular Aperture Diaphragm) (Number of Blades: 7, Circular Aperture Diaphragm)

Mount Type Samsung NX mount Samsung NX mount

Optical Image Stabilizer Not included Not included

Minimum Focus Distance | 0.28 m ~ infinity 0.17 m ~ infinity

Maximum Magnification

Approx. 0.22X

Approx. 0.18X

Supported(Beauty, Portrait, Children, Backlight, Landscape,

Supported (Backlight, Landscape, Sunset, Dawn,

I-Scene Mode Sunset, Dawn, Beach&Snow, Night) Beach&Snow, Night)
Filter Size 40.5 mm 43 mm

Max. Diameter x Length | 64 x 39.8 mm 62.2 x 24.5 mm
Weight Approx. 119 g Approx. 89 g
Operating Temperature 0~40°C 0~40°C

Operating Humidity 5~85% 5~85%
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Lens Name

Focus Length

SAMSUNG 30 mm F2

30 mm (equivalent to 46.2 mm in
35 mm format)

SAMSUNG 18-55 mm
F3.5-5.6 OIS

18 ~ 55 mm (equivalent to
27.7 ~ 84.7 mm in 35 mm format)

SAMSUNG 50-200 mm
F4-5.6 ED OIS

50 ~ 200 mm (equivalent to
77 ~ 308 mm in 35 mm format)

Elements in Group

5 elements in 5 groups
(1 aspheric lens included)

12 elements in 9 groups
(1 aspheric lens included)

17 elements in 13 groups
(2 low dispersive lenses included)

Angle of View 50.2° 75.9° ~ 28.7° 31.4° ~8.0°
F2 (minumum: F22), F3.5 ~ 5.6 (minimum: F22), F4 ~ 5.6 (minimum: F22),
Aperture (Number of Blades: 7, (Number of Blades: 7, (Number of Blades: 7,
Circular Aperture Diaphragm) Circular Aperture Diaphragm) Circular Aperture Diaphragm)
Mount Type Samsung NX mount Samsung NX mount Samsung NX mount
Optical Image Stabilizer Not Included Included Included
Minimum Focus Distance 0.25 m ~ infinity 0.28 m ~ infinity 0.98 m ~ infinity
Maximum Magnification Approx. 0.16X Approx. 0.22X Approx. 0.2X
Lens Hood Optional Included Included
Filter Size 43 mm 58 mm 52 mm
Max. Diameter x Length 61.5x21.5mm 63 x 65.1 mm 70 x 100.5 mm

Weight

Approx. 85 g (without hood)

Approx.198 g (without hood)

Approx. 417 g (without hood)

Operating Temperature

0~40°C

0~40°C

0~40°C

Operating Humidity

5~85%

5~85%

5~85%

a Lens may differ from your actual items.
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HDMI cable

You can view high-definition photos and
videos by connecting the camera to an
HDMI-compatible monitor with the HDMI
(HDMI type D) cable.

Camera bag

You can purchase the camera bag
separately.

Memory card

This camera accepts SD (Secure Digital) and
SDHC (Secure Digital High Capacity) memory
card.

Adapter

You can charge the battery by connecting
the adapter to the power outlet.

Strap
You can additionally purchase the straps.

Battery pack
AN cable / You can purchase additional battery packs.
You can connect to other devices by using

the A/V cable.

* These illustrations may differ from your actual items. Refer to the user
/ manuals of these optional accessories for details.
* Use only Samsung-approved accessories. Samsung is not responsible for
damage caused by using another manufacturer’s accessories.

Shutter release
Shutter release reduces shakiness when
used with a tripod.

Filter

You can create different colored effects by
attaching filters to your lens.
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A

Aperture 11,15
Auto focus 58

B

Battery
life 119
specifications 119

Bracketing 65, 67

C

Camera
connecting as removable disk 105
connecting to PC 105
disconnecting (Windows) 106
layout 25

Color space 57

D

Depth of Field (DOF) 12, 17

Digital Print Order Format
(DPOF) 103

Drive (see Shooting method) 65

E
Exposure Value (EV) 12, 75

F

Fader 77

Files
deleting 81
editing RAW format 111
photo format 51
protecting 81
transferring to Mac 106
transferring to PC 105
video format 51

Flash 69
bounce photography 22
guide number 21

F-number 12
Focal length 16

i-Function 43
Intelli-Studio 107
ISO sensitivity 14, 15, 52

L

Lenses

layout 31

locking 32
markings 34
specifications 129
unlocking 32

M

Maintenance 116
Memory card 117
Metering 71
MF assist 64

o

Optical Image Stabilization

(QIS) 74

Optional accessories
attach the electronic viewfinder 38
attach the GPS module 37
connect the flash 35
flash layout 35
GPS module layout 36

P

Photos
adjusting tone 112
editing 87
enlarging 83
shooting options 50
viewing on camera 80
viewing on HDTV 101
viewing on TV 100

Photo styles 56
PictBridge 102
Picture Wizard 56
Posture 10
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R

Red-eye effect 70
Rule of thirds 19

S

Samsung RAW Converter 110
Shooting method 65

Shooting modes
Aperture Priority 41
Auto focus (AF) 58
Lens Priority 42
Manual 42
Movie 47
Program 40
Scene 45
Shutter Priority 41
Smart Auto 39

Shutter speed 13, 15
Slide show 83
Smart Alboum 81

T
Timer 66

vV

Videos

options 77
viewing 85
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Correct Disposal of This Product
(Waste Electrical & Electronic Equipment)

(Applicable in the European Union and other European
countries with separate collection systems)

This marking on the product, accessories or literature indicates that
the product and its electronic accessories (e.g. charger, headset, USB
cable) should not be disposed of with other household waste at the
end of their working life. To prevent possible harm to the environment
or human health from uncontrolled waste disposal, please separate
these items from other types of waste and recycle them responsibly to
promote the sustainable reuse of material resources. Household users
should contact either the retailer where they purchased this product,
or their local government office, for details of where and how they can
take these items for environmentally safe recycling. Business users
should contact their supplier and check the terms and conditions of the
purchase contract. This product and its electronic accessories should
not be mixed with other commercial wastes for disposal.

Correct disposal of batteries in this product

(Applicable in the European Union and other European
countries with separate battery return systems)

This marking on the battery, manual or packaging indicates that the
batteries in this product should not be disposed of with other household
waste at the end of their working life. Where marked, the chemical
symbols Hg, Cd or Pb indicate that the battery contains mercury,
cadmium or lead above the reference levels in EC Directive 2006/66.

If batteries are not properly disposed of, these substances can cause
harm to human health or the environment.

To protect natural resources and to promote material reuse, please
separate batteries from other types of waste and recycle them through
your local, free battery return system.

This Class [B] digital apparatus complies with Canadian ICES-003.
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NOTE:

This equipment has been tested and found to comply with the limits for

a Class B digital device, pursuant to part 15 of the FCC Rules. These

limits are designed to provide reasonable protection against harmful

interference in a residential installation. This equipment generates, uses

and can radiate radio frequency energy and, if not installed and used in

accordance with the instructions, may cause harmful interference to radio

communications. However, there is no guarantee that interference will

not occur in a particular installation. If this equipment does cause harmful

interference to radio or television reception, which can be determined by

turning the equipment off and on, the user is encouraged to try to correct

the interference by one or more of the following measures:

* Reorient, or relocate, the receiving antenna.

* Increase the distance between the equipment and receiver.

» Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

» Consult the dealer or an experienced radio / TV technician for help.

CAUTION:

Changes or modifications not expressly approved by the manufacturer
responsible for compliance could void the user’s authority to operate the
equipment.

Declaration of Conformity

Trade Name : Samsung Electronics America, Inc.

Model No. : Samsung NX100

Responsible Party : Samsung Electronics America, Inc.

Address : 85 Challenger Road, Ridgefield Park, NJ 07660
Telephone No. : 1-800-SAMSUNG (726-7864)

This device complies with Part 15 of the FCC Rules.

Operation is subject to the following two conditions:

(1) This device may not cause harmful interference, and (2) this device
must accept any interference received, including interference that may
cause undesired operation.




Please refer to the warranty that came with your product
or visit our website http://www.samsungimaging.com/ or
http://www.samsung.com/ for after-sales service or inquiries.


http://www.samsungimaging.com/
http://www.samsung.com/
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